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1 Tekla Structures subscription
plans

Depending on your Tekla Structures subscription plan, you have access to the
Tekla Structures Diamond, Tekla Structures Graphite, or Tekla Structures
Carbon subscription.

Each subscription progressively enables more product features.

+ Tekla Structures Diamond subscription is for detailing and production
information.

+ Tekla Structures Graphite subscription is for modeling and design
documentation.

+ Tekla Structures Carbon subscription is for viewing and collaboration.

+ Tekla Structures Trial subscription is for trying the full functionality of
Tekla Structures, with some exceptions.

If you are a company administrator, you can view the subscription details in
the Tekla Online Admin Tool.
Trimble User Assistance and feature documentation

Trimble User Assistance covers the content of the Tekla Structures Diamond
subscription. Note that you might not have access to all features described in
Trimble User Assistance. If your subscription plan includes several different
subscriptions, you can choose which one to use when you start Tekla
Structures.

Preview features in Tekla Structures
Some of the features in Tekla Structures are released as Preview features.

Preview features are ready for production use, but the feature development
can continue based on the feedback. The Preview features are primarily
intended for evaluation purposes, providing an alternative approach to your

Tekla Structures subscription plans 7
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typical workflows. We encourage you to test these features in a normal
business environment and share your feedback.

NOTE: A Preview feature may be enhanced, updated, or discontinued at any
time in response to feedback. Preview features are provided “as is” without any
Trimble warranty or indemnity.

Feature map for Tekla Structures subscriptions

Diamond Graphite Carbon Trial

Modeling

Opening and | v v v v
viewing
models

Modeling of | v v v
parts, steel
assembilies,
precast cast
units,
concrete pour
units

Creating steel | v v v
and concrete
components

Creating v v v
unique part
marking

(numbering)

Intelligent v
batch editing
tools

Planning tools

Logistics v v v v
planning,
sequencing,
scheduling,
classifying,
status
visualization

Drawings and reports

Creating v v v v3
reports &
print drawings

Creating v v v
general
arrangement,

Tekla Structures subscription plans 8




Diamond Graphite Carbon Trial

rebar and
anchor bolt
drawings
(plan, section,
erection)

Creating steel | v v
and concrete
production
drawings
(part,
assembly, cast
units)

Interoperability

Exports for v V2 V2
steel CNC &
MIS systems

Exports to v 4 v
rebar
manufacturin
g systems

Exports for v v v
precast
concrete ERP
& MES
systems

Work with v v v v
reference
models (such
as DWG, DXF,
IFC formats)

Analyzing

Create 4 v v
analysis
models and
analysis loads

Analysisand | v v v
design
interfaces

Other

Open API v v (4 v
capabilities

Preview vi vi vi
features

Tekla Structures subscription plans 9



v 1 = Numbering is not available for steel or precast assemblies,
reinforcement is still numbered.

v 2 = Only existing models that are already numbered using a Tekla Structures
Diamond subscription can be opened and exported.

v 3 = Printing and exporting of drawings is not enabled.

v 4 = Preview feature availability depends on the feature and the subscription
or license type. For more information, see Preview features by license in Tekla
Structures.

Tekla Structures subscription plans 10
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2 Start Tekla Structures using the
classic startup screen

With Tekla Structures, you can create information-rich 3D models of all
structures and materials, and the 3D model is also the single source of
information for drawings and other outputs, such as reports and NC data files.

When you install Tekla Structures, two desktop icons appear:

5y

. 7B that launches the classic Tekla Structures startup screen
=Y
K

. 7B that launches the Tekla Launcher startup screen

To use the classic startup screen to start Tekla Structures, double-click the

desktop icon ~BAZE or select Tekla Structures from the Windows Start menu.

You are asked to choose your Tekla Structures setup. The setup consists of an
environment, role, and configuration.

+ Environment means region-specific settings and information. It defines, for
example, which profiles, material grades, default values, drawing settings,
component settings, reports, and templates are available and used for the
specific region.

* Roleis a user group profile that limits the availability of files and settings
in an environment. The user interface has been customized for each role,
meaning that some of the settings that are not relevant for the specific role
are hidden to make the user interface clearer and easier to use.

+ Configuration consists of a set of features that the user is entitled to based
on the license agreement.

If you are a company administrator, see Overview of environments, roles, and
configurations.

Start Tekla Structures using the classic startup 11
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2.1 Choose your Tekla Structures setup
1. Start Tekla Structures.
2. Signin using your Trimble Identity when prompted.

A dialog where you choose your Tekla Structures setup and the type of
license appears. Proceed with the default Tekla Structures subscription
option.

If you have an on-premises license, click Change license server --> Use
your on-premises license server.

Tekla Structures - Setup 9 x

1 Signed in as Switch user
. Choaose your Tekla Structures setup

 J

Environment

T9k|a UK v 0
Structures

Role

Steel Detailer v o

Configuration

Diamond hd o

Change license server Cancel

3. Select an environment that fits the region where your project is done.

If you cannot find the environment that you want in the list, see Install and
license Tekla Structures.

You can also select blank project and use it as the basis to create your
own customized environment.

4. Selectarole.

The availability of roles depends on your environment, but typically the
following roles are available:

+ Concrete Contractor

*  Engineer

+ General Contractor

* Precast Concrete Detailer

* Production Planner for Concrete

* Rebar Detailer

Start Tekla Structures using the classic startup 12 Choose your Tekla Structures setup
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+ Steel Detailer
5. Select a configuration.

The configuration that you are using might not contain all the features
described in the Tekla Structures product guides. For more information
on the features available in each configuration, see Tekla Structures
subscription plans (page 7).

6. Click OK.

The start screen appears.

Tekla Structures i — 0O X

Q‘ Tekla.Structures

& Trimble.

Your current Tekla Structures setup:
P35 Recent M All models <. Shared models {1 New =
Environment:
UK

Rale:

Steel Detailer
New model 1 7.9.2017 8.44.44 6.2.2021 23.06.26 i Configuration:

Diamond

New model 2 7.9.2017 9.40.49 10.2.2021 9.03.56 i Organization:

Trimble Selutions Corporation

New model 3 11.9.2017 12.51.09 15.12.2020 13.40.08 i

7. Select what you want to do:
+ Onthe Recent tab, you can open a recently used model (page 14).
If the Recent tab is empty, then the All models tab is shown.
+ On the All models tab, you can open any existing model (page 15).
If the All models tab is empty, then the New tab is shown.

On the Recent and All models tabs, you can sort each of the columns.
Additionally, you can change the order and size of the columns by
dragging them.

You can search models by name just by starting to type the name of
the model. For example, when you type N, Tekla Structures selects the
first model starting with the letter N.

To open the selected model, double-click the selected model, or select
the model and click the Open button.

« On the Shared models tab, you can open a model that has been
shared by using Tekla Model Sharing.

* Onthe New tab, you can create a new model (page 16).

TIP If you are unsure what to select or fill in on the Tekla Structures - Setup
and Tekla Structures - Start windows, rest the mouse pointer on the

o icon to see the tooltip.

Start Tekla Structures using the classic startup 13 Choose your Tekla Structures setup
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2.2 Create your own environment: blank project

Blank project is a Tekla Structures environment that includes only generic
content, such as parametric profiles, undefined bolt, material and rebar
grades, and basic drawing layouts. It can be used for gathering region-,
company-, or project-specific settings, tools, and information. The blank
project is always included in the Tekla Structures installation.

Download and install content to the blank project

You can use Tekla Warehouse to download and install content to the

blank project. For example, you can download profiles, material grades,

bolts, reinforcement, components, applications, and templates from Tekla
Warehouse across all environment- and manufacturer-specific collections, and
make combinations that suit your needs.

You can download and install content from Tekla Warehouse both before and
during a project. Before starting a project, you can install content to your
project and firm folders. During a project, you can install content to the model
folder.

2.3 Check your Tekla Structures setup

You can check your current Tekla Structures setup (environment, role,
configuration, and organization) at any time without having to close the model.

On the File menu, click Settings and scroll down to the Your current Tekla
Structures setup area. You current setup is displayed.

If you want to change your setup, restart Tekla Structures and change the
selection in the Tekla Structures - Setup dialog.

2.4 Open a model

You can have one model open at a time. If you open a model and already have
one open, Tekla Structures prompts you to save the first model.

Open a recently used model
1. On the File menu, click Open.

2. Click Recent.

3. Select a model in the list.

Tekla Structures shows the thumbnail image (page 17) of the model, if
you have added a one, and some basic creation information of the model.

Start Tekla Structures using the classic startup 14 Create your own environment: blank project
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4. To open the selected model, click Open or double-click the model.

If no views are visible in the model, Tekla Structures prompts you to select
one.

Open any existing model
1. On the File menu, click Open.
2. Click All models.
If you want to search for models in another folder, click Browse....

If you want to sort the models based on name or the modification date,
use the Order by sorting.

3. Select a model in the list.

Tekla Structures shows the thumbnail image (page 17) of the model, if
you have added a one, and some basic creation information of the model.

4. To open the selected model, click Open or double-click the model.

If no views are visible in the model, Tekla Structures prompts you to select
one.

Open a shared model

Shared models been shared by using Tekla Model Sharing.
1. On the File menu, click Open.

2. Click Browse shared models.

Tekla Structures prompts you to log in with your Trimble Identity, if not
already done so.

3. Select the shared model in the Shared models dialog.

Remove a model from the Recent models list

If you want to remove a model from the Recent models list, right-click a model
on the list and select one of the options.

+ Delete the selected item: delete the selected model from the list
« Clear all: remove all the models from the list

+ Clear invalid entries: remove all invalid models from the list, such as
deleted models that cannot be opened anymore

Note that the options are not available on the All models tab.

Start Tekla Structures using the classic startup 15 Open a model
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2.5 Create a new model

Create a separate model for each Tekla Structures project. Each model is
stored in its own folder under the TeklaStructuresModels folder.

1.  On the File menu, click New.
2. Inthe Name box, enter a name for the new model.
The maximum length of the name is 40 characters.

Do not use special characters(/ \ ; : |). We recommend that you try
to decide on a permanent name at this point. The name of the model can
be changed afterward, but it involves changing several file names.

3. Define where to save the new model.

By default, the model is saved in the TeklaStructuresModels folder
that was created during installation. You can change the default folder by
clicking Browse. You can also select a recently used folder in the Place in
list.

4. Select whether to run Tekla Structures in single-user or multi-user mode.
« Single-user: the model will be used by one person at a time.

* Multi-user: the model is stored on a server and may be used by several
people simultaneously. Enter the name of the server in the Server box.

5. If you want to use a model template, select one.

You can mark the important model templates as favorites, or hide the
templates that you do not need.

a. Select a model template in the list.
b. Right-click and select Favorite or Hidden.

If you marked a template as Favorite, it is placed on top of the
template list. Alternatively, use the star icon on the template to mark
it as Favorite, or to remove the marking.

If you marked a template as Hidden, it is removed from the template
list. Select the Show hidden items checkbox to show it again.

6. If you want to link the model to a Trimble Connect project, select the Start
Trimble Connect collaboration checkbox.

Linking the model to a Trimble Connect project happens after the model
has been created. For further instructions, see Link a Tekla Structures
model to a Trimble Connect project.

7. Click Create.

Tekla Structures creates the model and opens the default model view. The
contents of the model view may differ based on the model template you
chose in step 5.

Start Tekla Structures using the classic startup 16 Create a new model
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See also
Create a thumbnail image of a model (page 17)

Edit project properties (page 18)

2.6 Create a thumbnail image of a model

You can add a thumbnail image to make it easier to recognize your project
even when you do not remember the exact name of the model. The thumbnail
image is displayed when you browse for existing models.

1. Onthe View tab, click m Screenshot --> Project thumbnail.

2. Select a view.

Tekla Structures creates the image and saves it in the model folder with
the name thumbnail.png.

3. To check the thumbnail, go to the File menu, click Open, and select the
model you created the thumbnail for in the Recent or in the All models

list.
The image is now displayed with other model information. For example:

MyModell
Environment  default &
Version 2019
Created 20.11.2018 16.33.24
Modified 20.11.2018 16.33.24
Language Enu

Convert to multi-user model

C:\TeklaStructuresModels\MyModel1

4. If you are unhappy with the thumbnail image, you can repeat steps 1-2 as
many times as you need.

For example, you can zoom the model in and out to adjust what is
shown in the thumbnail image. When you create a new thumbnail, Tekla
Structures overrides the existing thumbnail image with the new one.

TIP Alternatively, if you want to use a custom image, you can add the image directly
to the model folder with the name thumbnail.png. The preferred size of the
image is 120 x 74 pixels.

Start Tekla Structures using the classic startup 17 Create a thumbnail image of a model
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2.7 Edit project properties

You will need project information, such as project number and name, many
times during a project. Update the project properties at the beginning of
each project to make reports and drawings display the correct information
automatically. All of the fields are optional.

1. Onthe File menu, click Project properties.

2. Edit the general project properties, and enter a description that helps you
identify the model when you next need to open it.

The description is listed with the other model information when you select
a model in the Recent or in the All models list.

The limit for the length of the description is 78 characters.

When you edit the properties, Tekla Structures highlights the modified
properties in yellow. When you are ready with the modifications, click
Modify to apply the changes.

3. If you want to use another coordinate system for interoperability and
collaboration, click Base points to define a new base point.

Once a base point has been defined, you can select it from the Location
by list.

4. To define project-specific user-defined attributes, click User-defined
attributes.

By default, you can define:
* Project comment

« User fields

« Execution class

+ Classification system

« |FC export attributes, like IFC site name, IFC building name, IFC building
storey name, and IFC bridge name

+ Status attributes
+ Unitechnik factory location

The availability of the various user-defined attributes depends on your
environment (page 12), role and configuration (page 7).

Once you are finished with editing the project properties, as a result, you will
get updated project properties in drawings and reports.
Displaying project information in templates and reports

The fields in the image below refer to template attributes, which you can
use when designing your own reports and templates. To display project
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information, add the corresponding template attributes in the templates and
reports.

Project properties
General
Project number
Marme

Builder

Object
Designer
Location
Address

Postal box

City

Regicn

Postal code

Country

Start date
End date

Info 1

Info 2

Descripticn (0/78)

(1) NUMBER#2
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(2) NAME

(3) BUILDER

(4) OBJECT

(5) DESIGNER

(6) LOCATION

(7) ADDRESS

(8) POSTAL_BOX
(9) TOWN

(10) REGION

(11) POSTAL_CODE
(12) COUNTRY
(13) DATE_START
(14) DATE_END
(15) INFO1, INFO2
(16) DESCRIPTION

2.8 Save a model

You should save your model regularly to avoid losing any work. Tekla
Structures also automatically saves your work at regular intervals.

NOTE Tekla Structures versions are not backwards compatible. When you save
a model, you cannot open it in older versions of Tekla Structures due to
database differences.

Save the current model
To save changes to the current model file, do one of the following:

5
* Onthe top left corner of the screen, click Save H
* On the File menu, click Save as --> Save.

*  Press Ctrl+S.
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Save a copy with different name or location

You can create a copy of the model with a different name or in a different
folder. The original version of the model remains intact.

NOTE When you save the model with a different name, all the GUIDs
(globally unique identifiers) of the saved model will change and be
different than in the original model. This means that the saved model
has no relation to the original model, and the saved model cannot be
used as backup.

1.  On the File menu, click Save as --> Save as.

In the Model name box, enter a new name.

To save in a different location, click Browse and define where you want to
save the model.

4. Click OK.

Tekla Structures creates a new copy with a different name, but the original
version of the model remains intact.

Save a backup copy

You can create a backup copy of the model with the same GUIDs (globally
unique identifiers) as the original model.

1. Onthe File menu, click Save as --> Save and create backup copy.

Tekla Structures saves a copy of the model
inthe . .\TeklaStructuresModels\backup\<model name>\<date-
time> folder.

2. If you need to take the backup copy into use in place of the current model,
move the backup copy from the chosen date to your model folder.

You can either replace all contents of the current model folder with the
content of the chosen backup folder, or you can rename the backup
folder (<date-time>) to match the original model name.

3. If you want to change the location of the backup folder, use the advanced
option XS_MODEL_BACKUP_DIRECTORY.

NOTE To save disk space, you can compress the
XS MODEL BACKUP DIRECTORY folder.

Start Tekla Structures using the classic startup 21 Save a model
screen



Save as a model template

You can save a model with the desired settings and use the model as a
template when you create new models.

Define model and drawing autosave settings

Use Autosave to automatically back up and save your work at set intervals
to minimize work loss during modeling and drawing editing. You can set
the autosave interval for the model and the active drawing using the same
Autosave setting. Additionally, you can define that autosaving is done for
drawings after a certain number of drawings has been created.

If the autosave is not successful for some reason, check the status bar
messages (page 65) for more information.

1. On the File menu, click Settings --> Options, and go to the General
settings.

2. Under Autosave, set the autosave interval for the model and active
drawing.

a. Inthe first box, enter the number of minutes after which Tekla
Structures saves the model and active drawing. The default value is
15 minutes.

If there are no changes in the model during the autosave interval, the
model is not autosaved.

There will always be at least one model autosave when a drawing
is autosaved. Subsequent drawing autosaves will not trigger model
autosave unless there are model modifications.

If you save the model manually, the autosave interval is reset to
prevent the model from being autosaved immediately after a manual
save.

b. Inthe second box, enter the number of created drawings after which
Tekla Structures saves your work.
NOTE The smallest accepted value for the autosave interval is 2 for both
boxes.

If you try to enter a value smaller than 2, Tekla Structures
automatically changes the value to 2.

3. Click OK.
Define where to store the Autosave files.

By default, Tekla Structures stores the autosave files
in the C\TeklaStructuresModels\autosave folder with the
extension .dbl <user>. The drawing is saved in the model
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autosave folder in the \drawings subfolder, for example,
C:\TeklaStructuresModels\autosave\House\drawings. To change
the folder, use the advanced option XS_AUTOSAVE_DIRECTORY.

5. Define whether to keep old model autosave files.

By default, Tekla Structures deletes the model autosave files when you
close a model, to save disk space. To keep model autosave files even if you
exit Tekla Structures without saving the model, use the advanced option
XS_KEEP_AUTOSAVE_FILES_ON_EXIT_WHEN_NOT_SAVING.

When you close a drawing normally (with or without saving), the drawing
autosave file is deleted. Also, when you save a model, both model and drawing
autosaves are deleted. This way, there is only one autosaved drawing at a
time. When you close the model, model autosaves are deleted unless the
advanced option XS_KEEP_AUTOSAVE_FILES_ON_EXIT_WHEN_NOT_SAVING is
set to TRUE.

Restore autosaved model and drawing

You can use the autosaved model if there are errors when trying to open a
model (page 14).

1. Open the model.

Tekla Structures automatically checks if the previous session ended
normally. If the previous session did not end normally, opening the active
model prompts you to open either the manually or automatically saved
model version. The dialog includes the following information:

« The name of the autosaved drawing, if any

« The path to the autosaved version of the model and the autosaving
time

* The path to the last manually saved version of the model and the
saving time
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Open

Autosaved data exists for this model. Click Autosaved if you want to cpen the
autosaved version. Click Saved if you want to open the actual model instead.

Autosaved version of drawing found:
G [1] GA-drawing

Autosaved version of the model found:
n C:AhTeklastructuresModelshautosave WMew model 3448 Mew model
344.db1_<user=
2025-11-21 1:35:20
12322 bytes

Last saved version of the model:
C:hTeklaStructuresModelstMew model 344\Mew model 344.db1
2025-11-21 1k22:15

10289 bytes
Autosaved Cancel

2. To restore the autosaved version of the model, select Autosaved.

If there is an autosaved drawing, Tekla Structures opens the autosaved
model and the drawing automatically.

When the drawing is opened, there is a notification that autosaved
drawing was opened and saved.

A Autosaved drawing opened X
Tekla Structures

Autosaved version of the drawing A - [C.1] COLUMN has been

opened automatically and saved.

If you prefer to use the autosaved version of the model, save
the model immediately.

If you want to open older versions of this drawing. use the
Drawing versions feature in Document manager.

Open drawing versions

-

3. Check the drawing and choose if you want to keep or discard that version.

Do one of the following depending on whether you want to keep the
autosaved drawing:

+ Save the model as soon as possible.

+ If you do not want to restore the autosaved drawing, click Open
drawing versions to open the Drawing versions feature and select a
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previous version and save that instead. The Drawing versions feature
can be used through Document manager.

Fatal hardware problems

If Tekla Structures displays the warning Fatal: Model memory corrupted by
read, it means that hardware problems have damaged the model database.
Your hard disk may be damaged. Use autosave or system backup files to
restore the model.
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3 Start Tekla Structures and open
models using Tekla Launcher

Tekla Launcher is an alternative way to start Tekla Structures and to open and
to create new models. Tekla Launcher allows the creation of models with all
installed versions of Tekla Structures, although there are some limitations with
older Tekla Structures versions.

Using the Tekla Launcher you can open and create models and open and join
Tekla Model Sharing models without downloading and installing environments
from Trimble Downloads. With the Tekla Launcher, the environments are
stored and managed in a cloud service, ensuring that everyone working on

a model is using the same environment with consistent settings and files. With
the Tekla Launcher you have easy access to recent models, and you can create
new models using readily available environments.

The Tekla Structures environments in the cloud service and those downloaded
from Trimble Downloads are built from the same source, so the content of the
environment files is the same.

Additionally, the Tekla Launcher supports project settings and company
collections that have been created in the Project Settings Management
Console, which is a web-based tool that lets you manage your project settings,
environments, and other project files in the cloud. Once you have created

your settings in the Project Settings Management Console, Tekla Launcher
automatically retrieves the published settings from the cloud. This allows

you to create new models where all users consistently apply the same

project settings. Note that Project Settings Management Console is a preview
feature, and all related functionalities supporting Project Settings Management
Console have the preview status in Tekla Launcher.

Tekla Model Sharing models that have been created using the Tekla Launcher
are restricted to the environment and environment version that they were
created in. This ensures that all users collaborating on the shared model are
using the same environment.

When you install Tekla Structures, two desktop icons appear:
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oY

-
« A_lthat launches the Tekla Launcher startup screen.

Ny

-

. 7B that launches the classic Tekla Structures startup screen.
To use the Tekla Launcher to start Tekla Structures, double-click the desktop

51

-
icon 'l or select the Tekla Launcher from the Windows Start menu.

The first time you open the Tekla Launcher, a dialog where you select your
Tekla Structures subscription opens. The subscription option that includes
the highest level of features is automatically selected. If you have multiple
subscriptions, you can switch between the subscriptions.

= - o
Trimble.
B Thla | Launcher O ® % 8 @& &
RECENT MODELS SHARED MODELS NEW SAMPLE MODELS
= C ‘ a | e El e\TeklsStructureshodels ‘ v m NETTEE R
- 4 Version: 1.0.99
Users Model name i L d Version Version label
Restart to install a newer version
m e < Default 2025-12-021 -
Subscription
m < Default 2025-11-27 0. 2025 Diamond - Single User
Trimble
m 28 Defautt 202511250 2006
m < Dafault 2025-11-101 2026 Learn the product
m 2 Default 2025-10-09 1., 2025 - ,é_ &Y Tekla.
i
m 2 Default 2025-08-28 1... i
- s
m o Default 2025-08-15 1... P, i
m e é Default 2025-07-01 1 99 Core training

see the potential and
learn the basics

3.1 Create a new model in Tekla Launcher

You can create new models with all installed versions of Tekla Structures.
1. Go to the New tab.
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2. To create a new model without using any model templates, go to the New
blank model template and click Create.

The Create new dialog appears.

Create new

BASIC INFORMATION Thumbnail

Model name

| MyModel | ®

Description

Drag an image here or browse for an image. Only
.png. .jpeg. and .bmp are supported.

TEKLA STRUCTURES (D

| 2026.0 Daily : 2026.0 Daily : (226.0.6873) v ‘ Lem e e mccmcmccmmmmmm—————————— 4

ENVIRONMENTS

Environment
Apply company settings (Preview)

Felect A
Belect ® Company collection
: y settings (Preview) v
iR Custom (Preview) (10) @ v Company semings (Fre - ‘ G)
Upgrade behavior
& Timble (35) © v [E— v ©
& Classic (2) @ s

3. Enter a name and a description for the new model.
Select the installed Tekla Structures version.

5. Select the environment. Environments are filtered based on the selected
Tekla Structures version.

+ Custom (Preview): Custom environments contain project settings and
company-specific environments. These are all cloud environments. The
custom environments are created or managed by the company or the
user.

Environments that are locally available have an icon indicator and are
shown on the top of the environment listing for quicker access.

Select the upgrade behavior of the selected custom environment:

« Use current version: The model is always created using the same
version.

+ Use the latest minor and patch updates within the current
major version: Use the latest version within the current major
release. For example, if the model was created with version 2.0.0
and a new version 2.1.0 is available, the newer version will be used.

+ Use latest version: The model will be upgraded to the latest
version when opened.

+ Trimble: Official Trimble environments are provided by Trimble.
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+ Classic: Classic environments are installed locally on your computer
or are created by users. You can download the environments from
Trimble Downloads.

6. If you use the Custom (Preview) environments, select if you want to apply
company settings that have been created in Project Settings Management
Console.

Company collections are a customizable group of settings that are used
when a new model is created.

Select the company collection and its upgrade behavior.
7. Add a thumbnail image for the model, if needed.
8. Click Create new.

If you selected a cloud environment, the environment is downloaded from
the cloud.

9. Select a Role that is used in the model.
The availability of roles depends on your environment.

10. Click Select.
All data is downloaded during model creation and cached locally.
Tekla Structures is started and model opened.

Create a new model using a model template

If you want to create a model using a model template, select a suitable
template on the New tab.

1. Onthe New tab, select a model template.

Model templates defined in XS MODEL TEMPLATE DIRECTORY in
user.ini for different Tekla Structures versions are automatically
imported to the Tekla Launcher. You can find these templates when you
select the Only my company's templates checkbox.

Models uploaded to Project Settings Management Console are also
available in Tekla Launcher.

Additionally, model templates

in . .Users\<User>\AppData\Local\Trimble\Tekla
Structures\<version>\UserSettings\ModelTemplates are
imported to Tekla Launcher.

Each model template in Tekla Launcher has a card that displays the
environment and role used in the template. If the card has a Trimble logo,
the model template has been created by Trimble.
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You can mark important model templates as favorites. Favorites are user-
specific settings and saved on your computer for each Tekla Structures
version.

You can use the search on the left to find model templates. You can
search by text in the template name or description, or by region or
industry.

Click Create.
Enter a name and a description for the new model.

Add a thumbnail image for the model, if needed.

vk N

Click Create new.

All data is downloaded during model creation and cached locally.
Tekla Structures is started and the model is opened.

Metadata for locally created model templates

Locally created model templates provide some metadata in the template-
metadata.json file.

The supported metadata IDs are:
SupportedEnvironments, SupportedRegions, SupportedIndustries

SupportedEnvironments format is Environment{Role b, Role a}

example:

{

"metadataPairs": [

{
"MetadataDefinitionId":"SupportedEnvironments",
"Value":"SwitzerlandEnvironment"

by

{

"MetadataDefinitionId":"SupportedRegions",
"Value":"Switzerland"

by

{
"MetadataDefinitionId":"SupportedIndustries",
"Value":"All1l"

}

]

}

Use extensions in model templates

Model templates can import extensions, which are downloaded from
Tekla Warehouse when creating a model. This requires a tsep-
dependencies.json file.

{

"name": "FinlandEnvDefinition",

"version": "1.0.0",

"tsepDependencies": [

{

"id": "twh-concrete-bridge-reinforcement",
"name": "Concrete Bridge Reinforcement",
"version": "1.3.0",
"guid": "ub572366a7-a2a30-42b0-96c8-53ac730c793e"
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"id": "twh-beam-extruder",

"name": "Beam Extruder",

"version": "71.0.0",

"guid": "ucf5ded03-9487-42ba-8333-dab5302ed449"

"name": "BEC Custom properties",
"version": "1.0",
"guid": "775c6138-bb20-4b3a-94d5-6£26810d81e3"
}
]
}

You can treat content in Tekla Warehouse as immutable, meaning that

once the content is uploaded, it cannot be modified. Immutable content is
identified by an ID with the prefix twh, which ensures that package versions
remain unchanged. Non-immutable content can still be used, but we cannot
guarantee that if a version is replaced in Tekla Warehouse, clients can use
the replaced version because of the caching of the extensions. Therefore, for
non-immutable content, use only the GUID.

These are the upgrade rules:
*  x.y.z - specific version - you manage the updates
* “x.y.z-upgrades the major version to the latest

* latest - upgrade to the latest version

3.2 Open a recently used model in Tekla Launcher
1. Gothe Recent tab.
2. Select a model in the list.
3. Click Open. Alternatively, double-click the selected row.
Tekla Structures is started and the model is opened.

Tekla Launcher opens the model using the same settings that were used
most recently. This makes opening the model faster, because you do not
need to select the role in the Role dialog.

TIP To quickly open a previously opened model, right-click the Tekla
Launcher icon on the Windows taskbar or on the Windows Start
menu.

3.3 Open any existing model in Tekla Launcher
1. Go to the Models tab.
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Select a model in the list.

Click Open. Alternatively, double-click the selected row.
Select a suitable role in the Role dialog and click Select.
Tekla Structures is started and the model is opened.

If you need to perform other actions on the selected model, click the three
dots *** nextto the Open button and select an action.

+ Open using another environment: Change the selected environment
of the model. Note that when you save the model after changing the
environment, this can affect the model setup and the model might get
corrupted.

+ Open model folder: Open the model folder in File Explorer in
Windows.

+  Modify model properties: Add a description and a thumbnail image
for the model, or change the company settings and the upgrade
behavior.

«  Rename: Enter a new name for the model.

+ Open using another Tekla Structures version: Select the Tekla
Structures version in which the model is opened.

+ Exclude from sharing: If you have a model that has been shared using
Tekla Model Sharing, you can exclude yourself and your local version
of the model from the sharing service.

« Pin model: Pin the model so that it always stays on top of the model
listing.

3.4 Open a shared model in Tekla Launcher

You can open and join Tekla Model Sharing models on the Shared models tab.
You can also see basic information about models that have been shared with
you, such as the name of the project, the environment, and your Tekla Model
Sharing role.

You can also open a shared model on the Recent or Models tabs.

1.

Go to the Shared models tab.

2. To quickly open the model, click the open button
3. To open the list of actions you can perform on Tekla Model Sharing the
model, click the arrow on the left, next to the model name.
4. If you have the Owner role in the Tekla Model Sharing model, you can do
the following:
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+ Open: Open the shared model.

+ Track environment version/ Stop tracking the environment
version: Check and change the environment and the environment
version used in the model, and to enforce other users in the shared
model to use the environment and the environment version that you
have set.

For models that have been created in the Tekla Launcher and then
shared, the environment tracking is on by default.

If environment tracking is not on, click Track environment version

to change the environment in use and/or select the version of the
environment. After making the changes, click Save changes. Select a
suitable role in the Role dialog and click Select to open the model.
Check that the model works correctly and write out the environment
setup changes to the sharing service. Other users are prompted in
Tekla Structures to restart the application and to read in. They are then
enforced to use the environment and version that you have set.

To stop the enforced usage of the same environment and environment
version, click Stop tracking the environment version and select a
suitable role in the Role dialog and click Select to open the model.
Write out the changes. Other users are prompted in Tekla Structures to
restart the application and to read in. They are no longer enforced to
use the same environment or version as you.

For more information, see Tracked environment versions for Tekla
Model Sharing models below.

+ Change environment version: Check and change the version of the
environment used in the model. After making the changes, click Save
changes. Select a suitable role in the Role dialog and click Select to
open the model. Check that the model works correctly and write out
the environment version changes to the sharing service. Other users
are prompted in Tekla Structures to restart the application and to read
in.

* Modify company settings(Preview): Change the company settings
and the upgrade behavior.

+  Open model folder: Open the model folder in File Explorer in
Windows.

* Model information: Check the model's project properties.

*  Model versions: Check the model versions of the shared model, and
whether the type of the model version is update or baseline.

5. Ifyou have any other role than Owner in the Tekla Model Sharing model,
you can do the following:

+ If you have not yet joined the model, you can click Join latest: Join the
latest version of the shared model.
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+ If you have not yet joined the model, you can click Join a previous
version of the shared model: Select any previous version of the
shared model to join.

+ After you have joined the model, you can click Open: Open the shared
model.

+  Open model folder: Open the model folder in File Explorer in
Windows.

* Model information: Check the model's project properties.

*  Model versions: Check the model versions of the shared model, and
whether the version is an update or a baseline.

6. Select a suitable role in the Role dialog and click Select.
Tekla Structures is started and the model is opened.
Tracked environment versions for Tekla Model Sharing models

If you start Tekla Structures using the classic startup screen, there is no
enforcement to use a specific environment or environment version with Tekla
Model Sharing. This means that you can start Tekla Structures with any
environment and join any Tekla Model Sharing model without restrictions. This
flexibility can be beneficial but it may also lead to inconsistencies in shared
models, for example, in a situation where two Tekla Model Sharing users are
working on the same model using different environment versions.

The environment tracking in the Tekla Launcher enforces the Tekla Model
Sharing models that have been created using the Tekla Launcher to be
restricted to the environment and environment version in which they were
created.

The following applies to Tekla Model Sharing models that have been created
and shared in the Tekla Launcher:

* Only those Tekla Model Sharing users who have the Owner role can
change the environment and its version.

+ Only those Tekla Model Sharing users who have the Owner role can track
and untrack an environment.

+ Changes to the environment and its version always need to be written out
to the sharing service.

+ If the version of the environment changes, users are prompted in Tekla
Structures to restart the application and to read in the new version of the
environment.

+ Tekla Structures service pack updates do not enforce a new version of the
environment. Those users who have the Owner role need to upgrade to
the new version of the environment.
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3.5 Explore sample models

On the Sample models tab you can explore sample models that are curated
by Trimble and partners to show different workflows.

Sample models are created and maintained in the Project Settings
Management Console, and they are downloaded from cloud on demand.

3.6 Adjust Tekla Launcher to your needs

*  Click

You can sort the modes in the tiles view according to different sort criteria.

to show the model listing as a table or as tiles.

+ Use the search * ' to find a model.

+ To change the model folder where Tekla Structures models are saved by

E cATeklaStructuresMaodels | A m

By default, the models are saved in the TeklaStructuresModels folder.
You can change the default folder by clicking Browse, or typing a new
folder location.

default, go to

* Inthe upper right corner, click
and help to improve the tool.

to give feedback on the Tekla Launcher

-

* Inthe upper right corner, click < to switch to the classic Tekla Structures
startup screen. The classic Tekla Structures startup does not use any of the
cached environments that the Tekla Launcher uses, and you need to install
the environments from Trimble Downloads on your computer.

* Inthe upper right corner, click w to open Project Settings Management
Console where you can manage your project settings, environments, and
other project files in the cloud.

* Inthe upper right corner, click = to show your subscription options and
to switch to a different subscription, if you have multiple available. Note
that only online subscriptions are supported.

* Inthe upper right corner, click @ to change the language of the Tekla
Launcher.
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* In the upper right corner,

- . L ;
* indicates that you are working in online

mode and that you have access to the cloud environments enabled.

You need to have a license saved locally to use the Tekla Launcher in offline
mode. When you close Tekla Structures, select the checkbox for saving the
license. If you are in the offline mode, you can create a new model if you
have locally installed environments, or you have cached environments. You
can open a local model, but joining shared models requires an internet

connection.

3.7 Tekla Launcher installation

Tekla Launcher is a lightweight installer. It installs files into the
%$localappdata%\TeklaLauncher folder, which also contains the application

Tekla
Launcher file
locations

itself.

Tekla Launcher operates as a service, receiving automatic and continuous
updates whenever fixes and new features are released. Available updates
are displayed in the user interface. To download and install a newer version
automatically, click Restart to install a newer version.. After the update,
Tekla Launcher restarts automatically.

Path

Function

Notes

.. \Users\<user>\.te
kla-launcher

Base path for Tekla
Launcher data.

You delete this
manually. Tekla
Launcher will create the
data as needed.

.. \Users\<user>\.te
kla-
launcher\<version>

Cloud environment
specific data, cloud
XSDATADIR.

Each version of

Tekla Structures saves
its files separately

to prevent conflicts
between versions.

Adding new files to this
location is not allowed.

You can delete this

manually.
..\Users\<user>\.te | Cloud data cache. You can delete this
kla-launcher\Caches manually.

. .\Users\<user>\.te
kla-
launcher\Caches\Col
lections

Cloud collections
runtime area.

Tekla Structures reads
files from this location.

You can delete this
manually.
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Path

Function

Notes

. .\Users\<user>\.te
kla-
launcher\Caches\Env
Cache

Classic environments'
cache.

Compressed files will be
stored in this location.

You can delete this
manually.

.. \Users\<user>\.te
kla-
launcher\Caches\Env
Sandbox

Sandbox runtime area.

You can delete this
manually.

. .\Users\<user>\.te
kla-
launcher\Caches\Mod
elTemplatesCache

Local model template
cache for offline use.

You can delete this
manually.

. .\Users\<user>\.te
kla-
launcher\Caches\Pkg
Def

Cloud package
definitions' runtime area.

Tekla Structures reads
files from this location.

You can delete this
manually.

. .\Users\<user>\.te
kla-
launcher\Caches\Tse

P

Cloud . tsep isolated
location.

Tekla Structures loads
extensions from this
location.

You can delete this
manually.

%$localappdata$% Tekla Launcher settings | Create a backup before
\Trimble\Tekla folder. deleting this folder to
Launcher keep your settings.
$localappdata$% Settings file for Tekla Manual changes are not
\Trimble\Tekla Launcher. This file stores | recommended because

Launcher\TeklaStruc
turesLauncherSettin
gs.xml

actions performed in the
user interface.

they can lead to
serialization errors.

$localappdata$% Runtime logs for Tekla In case of errors, this
\Trimble\Tekla Launcher. log file is needed for
Launcher\Logs troubleshooting
$localappdata$% WebView?2 cache, Tekla | You can delete this
\Trimble\Tekla Launcher user interface. | manually.
Launcher\Cache

%$localappdata%l\Tri
mble\Tekla
Structures\<version
>\Runtime

Start Tekla Structures and open models using

Tekla Launcher

Tekla Structuresversion-
specific . ini and other
generated . ini files.

role-xxxx.1ini

bypass-xxx.ini

New files are generated
each time a model

is opened or created.
This ensures that Tekla
Structures can run

teklastructures-
XxXx.1ni
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Path

Function

Notes

side-by-side with other
versions.

The files from the last
five runs are saved.

Start Tekla Structures and open models using
Tekla Launcher
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Introduction to Tekla Structures
user interface

When you open a Tekla Structures model, a new window appears. By default,
the user interface will look something like this:

STy HCo Tekla Structures - C:\TeklaStructuresModels\New model 00 0 14 - o X
< _STEEL CONCRETE REBAR EDIT  VIEW DRAWINGS & REPORTS MANAGE ANALYSIS &L DESIGN > Quick Lounch Q
4 ltem > - X

k- < g A B = i = =1 N
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27 | Column Beam Plate Bolt Weld  og pecembly . Column  Beam  Panel Slab Footing n Window
>
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8 Model origin ¥ Search in model Q @ ®OoA X d #/ X~ X 7 B W Auov Viewplaner  Outlineplanesy @
kA EHEL /9B AXDOEYN F SRS ¢ B L BB L stndrdvy @ || ©
Pick the start point for the beam. 0 Pan  Current phase: 1, Phase 1 0 objects and 0 handles selected

(1) This is your Tekla Structures model. If you are starting a completely new
project, you will only see the default model view and an empty grid at this
point.

(2) The green cube symbol represents the global coordinate system and it lies
at the global origin (x=0, y=0, z=0).

(3) The box around the grid represents the work area. In a view, you can only
see the parts that are within this area. Objects that are outside the work area
exist in the model, but they are not visible. You can shrink and expand the
work area to suit your needs. You can also hide the work area box.
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(4) The coordinate symbol with the x, y, and z axes represents the local
coordinate system. It also indicates the direction of the model. Click the
navigation control axes to rotate the model view from 3D to a selected plane
view.

(5) The File menu is where you manage your models. You can save models
(page 20), print drawings, and import and export models, among other things.

(6) The ribbon contains all the commands and other functions you will use
when building your model. You can customize the ribbon according to your
needs.

(7) By default, the Quick Access Toolbar (page 66) contains the Save, Undo,
Redo, and Undo history shortcuts icons. You can customize the Quick Access
Toolbar according to your needs.

(8) The upper right corner shows your user-name and a green symbol
indicating that you are signed in and your subscription or license is working
as expected. If a clock symbol is shown instead of the green symbol, the clock
indicates that you are disconnected from the Tekla subscription service.

If you click the question mark, a help menu opens where you can find links to
different learning resources and to support and sales.

(9) If you cannot find the command or dialog you are looking for, search with
Quick Launch (page 43).

(10) Use the side pane (page 45) on the right side of the screen to check
instructions for the currently active ribbon command, view objects properties,
add reference models and components, attach point clouds, use custom
inquiry, or to find direct access to Online Services.

(11) The work plane handler toolbar controls which work plane you currently
have in use in the model.

(12) The model search toolbar enables a quick search for objects in the entire
model or within the selected model objects.

(13) The snap switches (page 62) control which positions you can pick when
creating objects.

(14) The selection switches (page 58) control which objects you can select.

(15) When you create objects, the status bar (page 65) will tell you how to
proceed and when to pick points.

4.1 How to use the ribbon and the commands on the
ribbon

All the essential commands in Tekla Structures are available on the ribbon.
The commands are grouped according to their use. You can modify the
appearance of the ribbon, and customize the content of the ribbon, if needed.
All commands throughout Tekla Structures work in the same manner.
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How to use commands on the ribbon

To

Do this

Find commands

Slide the ribbon right or left with your mouse, or scroll
with your mouse wheel.

STEEL CONCRETE REBAR EDIT VIEW DRAWINGS & REPORTS
k . A 7 ftem
é < LT b =
m = 1y Bl Bolted parts
.? - cColumn  Beam Plate Eolt Wweld

7% Assembly -

Some commands have more options under them. The
options become available when you click the command's
name:

-
.."' S

S T ’
Slab Footing

-
."'i..' Fad footing

."” Strip footing

command you
need for your

current task, if
you are unsure

Activate the On the ribbon, click the command.

\Svoa?tr:gnuqsgou The command runs until you end it or use another
command.

Check which Rest the mouse pointer on a command.

A small window called tooltip appears. Tooltips provide
more information about commands and also give
examples, hints, and tips. For example:

Measure distance (F)

Measure the distance between any two points in
the model, Use this command to measure inclined
or aligned distances, By default, the result contains
the distance and the coordinates, Follow the
instructions on the status bar.

Press Ctrl+F1 for more help on this,

Press CtrlI+F1 when a tooltip is open to find more help on
the command.

To switch the tooltips on or off, click File menu -->
Settings --> Switches, and then select or clear the
Tooltips checkbox.
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To

Do this

View more
detailed
instructions on
how to use the
currently active
ribbon command

In the side pane, click to open the Instructor side

pane window.

On the ribbon, click a command. The Instructor side
pane window shows short videos, steps and other
information on how to use the active command.

End command

Right-click and select Interrupt.

You can also press Esc.

Re-activate the
last command

Press Enter.

NOTE You can complete many commands by using the Enter or the space
key as a shortcut, or by using the middle mouse button.

To use the Enter key as a shortcut for completing commands, set the
advanced option XS ENTER FINALIZES COMMANDS to TRUE.

Change the appearance of the ribbon

You can change the order of ribbon tabs, choose how they are aligned, and
even hide some parts of the ribbon if you do not need them in your current
project. For example, if you are only modeling steel parts, you can temporarily
hide the Concrete tab.

To

Do this

Change the order
of tabs on the
ribbon

Drag and drop the tab titles.

Change how the
tabs are aligned

Right-click on the top bar of the ribbon, select Navigation
mode, and then select one of the options.

« Scroll visible: the ribbon movement is minimal when
you switch between the tabs

+ Align to left: the icons start from the left side of the
ribbon

* Align to tab: the icons start from the left side of the
current tab

Hide the tabs that
you do not need
in your current
project

Introduction to Tekla Structures user interface

1. Rest the mouse pointer on a tab title.

A small eye symbol appears next to the tab title:

I A
VIEW o

How to use the ribbon and the commands on the
ribbon
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To Do this

Click the eye symbol < .

The eye symbol changes and the tab title becomes
gray:

The View tab is now hidden from the ribbon. If you
slide the ribbon, hidden tabs appear as:

%

3. Tore-display the hidden tab, click the eye symbol
again.

Minimize the ribbon

You can minimize the ribbon to save space on your screen. When the ribbon is
minimized, the command buttons are hidden but the tabs are visible.

1. Right-click on the top bar of the ribbon, and select Minimized.

EDIT VIEW | DRAWINGS
Mavigation mode » L

Minimized

The ribbon is now minimized to save space on the screen:

Mu 9co
= STEEL CONCRETE REEBAR EDIT VIEW DRAWINGS & REPORTS

2. To access the commands when the ribbon is minimized, click a tab title.
The ribbon becomes visible so that you can select a command.

3. Torestore the ribbon, right-click on the top bar of the ribbon, and select
Minimized again.
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4.2 How to use Quick Launch to find commands, dialogs,
and toolbars

Use the Quick Launch box in the upper-right corner of the screen to find
commands, dialogs, toolbars, and other functions. The shortcut key for Quick
Launch is Ctrl+Q.

il awnch

1. In the Quick Launch box Quick Launc Q , enter a search term.
For example, type bolt if you are looking for bolt commands.

2. Wait for a list of search results to appear. For example:

Ribbon (4) Menu (2) All commands (29)

— Ribbon

‘. Add bolt points Edit—Points
fm  (Create bolts Stee
#m  Edit bolted parts Stee

T4 Measure bolt spacing Edit—Measure

— Menu
Bolt assembly catalog Catalogs

Bolt catalog Catalogs

— All commands
f. Add bolt points
Bolt assembly catalog
Bolt cataleg
Bolt properties
Component.Blind Bolt
Compeonent.Bolt Macro (41)

Component.Bolted Brace (181)

The search results show the location of the command. You can navigate
in the list by clicking the Recent, Ribbon, Menu, and All commands tabs.
The Recent tab lists 10 most recently started commands from the search
results.

Alternatively, you can navigate in the search results by using the up and
down arrow keys on the keyboard. Start the selected command by clicking
Enter.

Tekla Structures highlights the commands on the ribbon or on the File
menu. For example:
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If the command you have searched is in the side pane, Tekla Structures
opens the side pane window.

3. Torun acommand, click its name on the search results list.
Or press the Enter key to instantly run the first command on the list.

4. For some basic settings (page 51) and toolbars a checkbox appears in
front them on the search results list. Click the command to activate the
setting, or to have the toolbar visible.

All cormmands ()

— All commands

o Contextual toolbar Control + K

o Selecting toolbar

5. If you want to open the list of search results again, click the Quick Launch
box and the list opens automatically.

To clear the Quick Launch box, click the % button or press the Esc key.

See also
How to use the ribbon and the commands on the ribbon (page 40)

How to use the side pane (page 45)

4.3 How to use the side pane

Use the side pane windows, for example, to view object properties, and to add
reference models and components.

To Do this

Open a side pane | Click a side pane button to open a side pane window.
window

2
Click ®  to view model object properties using
Custom inquiry.

Click L to open Instructor and to view instructions
for the currently active ribbon command.
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To

Do this

Click @ to find shortcut access to the different
Online Services.

* Click * to see notifications and change settings for
notifications.

to attach point clouds to a model.

Click o to show the properties of model or drawing
objects.

Click v to show the reference models list.
Click ™ to open the Model views side pane window.
¢ Hi

Click ** to show the Applications & components
catalog.

When you click a side pane button, the side pane window
opens and becomes active. Active side pane windows

have blue buttons n

Keep multiple side
pane windows
open at the same
time

Tekla Structures opens only one side pane window at a
time by default. You can keep multiple side pane windows
open at the same time if needed, and on different sides
of the screen.

* Right-click a side pane button and select Single pane
or Stacked panes.

Single pane: Tekla Structures opens a new side pane
window and closes all the other open side pane
windows.

Stacked panes: Tekla Structures opens a new side
pane window and keeps the other open side pane
windows stacked on top of each other.

+ Click Ctrl+side pane button to open the side pane
windows stacked on top of each other.

You can resize the side pane windows, change their order
by dragging them, or attach them to other side of the

screen if you click the '= button in the upper right corner
of a side pane window.
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To

Do this

Float and attach a
side pane window

You can float or attach the side pane windows on the
different sides of the screen. You can select separately for
each side pane window where to place it.

To float a side pane window: click the '= button in the
upper right corner of a side pane window, and select
Float.

. . . [ .
To attach a side pane window: click the button in
the upper right corner of a side pane window, and
select Attach to left side, Attach to right side, or
Attach to bottom, depending on the current side
pane window location.

Alternatively, you can drag the side pane window to
the right side or to the left side or at the bottom of
the screen. The area where you can attach a side pane
window is marked with blue color.

e

0 o7
L5

If you move a side pane window and close Tekla
Structures, the side pane window will be opened in its
new position when you start Tekla Structures the next
time.

Move a side pane
window

When you position the mouse pointer on the upper part
of the side pane window, the upper part is shown in light
blue.

Grab the upper part of the side pane window and drag
the window to a new location.

++ Applications & components 9 X

Adjust the size
of a side pane
window

Resize a floating side pane window by dragging its
borders.

Find more help on
the content of a
side pane window

Click the @ button.
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To Do this

Close a side pane | You can close one active side pane window at a time, or
window several windows at one go if you have stacked them on
top of each other.

+ Click another side pane button to close the active side
pane window and to open a new window.

Click the ** button in the upper right corner of each
side pane window.

>
Click the arrow in the side pane.

If your floating side pane window disappears

If you have floating side pane windows and multiple displays, a side pane
window sometimes opens on a second display that is not connected to your
computer at the moment. To return the side pane window to the main display,
right-click the side pane button in question and select Attach to side pane.

See also
Introduction to Tekla Structures user interface (page 39)

Basic settings in the File menu (page 51)

4.4 Change object properties using the contextual
toolbar

Use the contextual toolbar to quickly view and change some basic properties
of a model or drawing object, view, grid, and so on.

A contextual toolbar symbol e appears next to the mouse pointer when
you click an object in a model or in a drawing. Click the symbol to open the
contextual toolbar.

COLUMN HEA40D v § X
0,00 2000 |- @
& B H D =

Use the keyboard shortcut Ctrl+K to show or hide the contextual toolbar.

You can customize the contextual toolbar (page 133) and select which toolbar
elements are visible.
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Modify object properties using the contextual toolbar

The changes that you make on the contextual toolbar are immediately applied
to the model or drawing. The available properties depend on the selected
object type.

1. Click an object in a model or drawing.
A contextual toolbar appears next to the mouse pointer.

If multiple objects are being selected, the contextual toolbar displays the
text varies for any properties that differ.

2. Change the object properties on the contextual toolbar.

The changes are applied immediately.

TIP Press the Tab key to move between the properties and command buttons on the
contextual toolbar.

Copy object properties using the contextual toolbar

Use this method when you want to quickly copy properties to a few objects
only.

1. Select the object you want to copy properties from.
A contextual toolbar appears next to the mouse pointer.

2. Click - Copy properties.
The mouse pointer changes into a paintbrush.
3. Select the object you want to copy properties to.

When the properties have been copied, the mouse pointer returns to
normal.

Note that user-defined attributes (UDAs) are not copied with the object,
even if you have customized the contextual toolbar and added UDAs to it.

4. To copy properties to multiple objects, double-click the - Copy
properties button.

Now you can copy properties to multiple objects. The pointer remains in
the paintbrush mode until you press Esc or start another command.
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Drawing commands on the contextual toolbar

In the model, the [ 2 Open or create drawings command on the contextual
toolbar opens a menu that lists the drawings created for the selected objects,
and contains the Create fabrication drawing command for creating single-
part, assembly and cast unit drawings, and a command for showing the
drawings created for the selected objects in Document manager, where you
can then open the drawings.

In drawings, you can use the contextual toolbar to quickly view and change
some basic properties of a drawing object, view, grid, and so on.

o X

G2 Il =) & =2

Other commands on the contextual toolbar

Many object types in modeling mode have the following commands available
on the contextual toolbar.

. The " Position command lets you modify the part position. When you
modify the settings in the dial, the object moves in the model accordingly.

. The @ Display detailing command displays all bolts, welds, cuts, fittings,
and other details belonging to the part, even if you had defined them as
hidden in the display settings. For concrete parts, Tekla Structures displays
also reinforcement, surface treatment, and surfaces.

«  The & View angle command lets you to select a top, back, right, bottom,
front, or left view of a part, component, or assembly. Tekla Structures
displays the object in the selected view angle.

Show or hide the contextual toolbar
You can define whether the contextual toolbar is visible in Tekla Structures.

1. On the File menu, click Settings.
2. Under Toolbars, select or clear the Contextual toolbar checkbox.

Alternatively, use the keyboard shortcut Ctrl+K to show or hide the
contextual toolbar.

Define the contextual toolbar's position

You can define the position of the contextual toolbar, relative to an object's
reference point.
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1. Select an object.

2. Hold down the Ctrl key and click the contextual toolbar with the left
mouse button.

A dashed line appears between the contextual toolbar and the object.

o
.t
!

3. Drag the contextual toolbar to a new position.

For example, you can position the contextual toolbar on the left side of
the selected object.

4. Release the left mouse button.

The contextual toolbar now appears in the position you defined, for
example on the left side of any object you select.

Pin the contextual toolbar in place

You can pin the contextual toolbar to a specific location on the screen, so that

the position is locked. For example, you could have it appear at the upper left

corner of the screen. In the locked state, the position of the contextual toolbar
is independent of the individual part’s location.

1. Drag the contextual toolbar to a new location.

2. Click * to pin the contextual toolbar to the new location.

The pin icon changes when the position is locked.

3. To unlock the position, click .

Minimize the contextual toolbar

You can minimize the contextual toolbar so that it takes less space on your
screen.

1. On the contextual toolbar, click =*. The contextual toolbar now has the
symbol e .

2. To restore the contextual toolbar to its original size, click =* again.
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4.5 Basic settings in the File menu
Use the toolbar settings and the switches in File menu --> Settings to control
some basic modeling and drawing settings.
1. In the upper-left corner of the screen, click File.

Y g

K-

2
m’

-

Go to Settings.

Under User interface, Switches, or Toolbars, switch the options either
on or off.

In drawings, under Color mode, click one of the options to change the
color mode to Black and white, Tekla Grayscale, or Color.

Alternatively, you can use Quick Launch (page 43) box uick Launch % to
control the toolbars and the switches. Start typing the name of the toolbar
or the switch, for example, smart, in the Quick Launch box and select the
toolbar or the switch on the search results list to activate the setting.

User interface

+ Toolbars: Use the option buttons to adjust the size of the icons on the
toolbars at the bottom of the screen, and at the same time the toolbar size.

+ Font size (Ribbon): Use the slider to adjust the ribbon font size. The
default font size is 11p.

Switches

Option Description

Smart select Change how drag-and-drop works for object
handles.

When the option is on, you can drag from object
handles without selecting them first.

When the option is off, you must select the
handles before dragging.
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Option

Description

Drag & drop

Activate or inactivate the drag-and-drop command.

When the option is on, you can use drag-and-drop
when copying or moving objects.

When the option is off, drag-and-drop cannot be
used.

Middle button pan

Change the panning mode.

When the option is on, you can move the model or
drawing using the middle mouse button.

When the option is off, you can move the model
using the left mouse button.

Centered zooms

Change the zooming mode.

When the option is on, the center point of zooming
is kept in the middle of the view, regardless of the
mouse pointer position.

When the option is off, the mouse pointer position
determines the center point of zooming.

Basic view auto
rotation

Activate or inactivate the auto rotation of part and
component 3D views.

When the option is on, Tekla Structures rotates the
view once whenever you create a new 3D view of a
part or component.

When the option is off, Tekla Structures does not
rotate the view.

Crossing selection

Change how area selection works.

When the option is on, all objects that fall at least
partially inside the rectangular area are selected,
regardless of the dragging direction.

When the option is off, the dragging direction
affects the selection of objects.

Rollover highlight

Switch the highlighting of objects on or off.

Depending on the rendering engine you are using,
OpenGL or DirectX, Tekla Structures highlights the
objects differently when rollover highlight is on.

When the option is on, Tekla Structures highlights
selectable objects when you move the mouse
pointer on them.

When the option is off, selectable objects are not
highlighted.
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Option

Description

Select on right-click

Change how objects can be selected.

When the option is on, you can select objects
also with the right mouse button. Also the related
context menu is displayed immediately.

When the option is off, you can select objects with
the left mouse button.

Automatic rotation

Define how the view point is set.

center When the option is on, the view point changes
whenever you click the middle mouse button.
When the option is off, the view point stays in a set
position.

Ortho Activate or inactivate orthogonal snapping.

Orthogonal snapping also works in drawings.

When the option is on, Tekla Structures snaps
to the closest orthogonal point on the plane (0,
45, 90, 135, 180 degrees, and so on). The mouse
pointer automatically snaps to positions at even
distances in the given direction.

When the option is off, orthogonal snapping is not
used.

Use legacy rendering

Activate or inactivate the DirectX rendering.

When the option is on, the legacy OpenGL
rendering is used.

When the option is off, the DirectX rendering is
used. DirectX rendering is better optimized for
modern graphics cards.

The rendering setting is model view specific, which
means that you can use a different rendering
options in different model views. If you switch
between the rendering options, you need to
reopen the model view to activate the new value.

Hatching of
overlapping surfaces

Introduction to Tekla Structures user interface

In the DirectX rendered model views, switch the
hatching of overlapping surfaces on the same
plane on or off.

When the option is on, the overlapping surfaces
are visualized with a hatch, and you can detect
duplicate objects or any overlapping parts.

When the option is off, the overlapping surfaces
are not visualized.
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Option

Description

Hatching is shown in views whose rendering option
is Parts rendered / Components rendered (Ctrl/
Shift+4).

If you switch the option on or off, you need to
reopen the view to activate the new value.

line

Dashed line for hidden

In the DirectX rendered model views, show or hide
dashed lines for part edge lines when the part
edge lines are hidden behind another part.

When the option is on, the dashed lines are shown,
making it easier to see, for example, if the part
flange is facing towards or away from the web, or,
in more complex 3D views, which part is on top of
which.

Using the dashed lines also increases Tekla
Structures performance in the transparent views.

When the option is off, the dashed lines are not
shown and the performance effect is removed.

Dashed lines can be shown in all views whose
rendering option is one of the following:

+ Parts wireframe / Components wireframe
(Ctrl/Shift+1)

+ Parts shaded wireframe / Components
shaded wireframe (Ctrl/Shift+2)

+ Parts grayscale / Components grayscale
(Ctrl/Shift+3)

+ Show only selected part / Show only selected
component (Ctrl/Shift+5).

If you switch the option on or off, you need to
reopen the view to activate the new value.

Tooltips

Show or hide the tooltips (page 40).

When the option is on, a small window with
examples, hints, and tips appears when you rest
the mouse pointer on a command.

When the option is off, no tooltips appear.

Snap tooltips

Show or hide the snap tooltips.

When the option is on and you start a command
that requires picking points, Tekla Structures
displays a snap tooltip that shows the name of the
snap point.

When the option is off, no snap tooltips appear.
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The following settings are available only in the drawing mode:

Option

Description

Printer line widths

Show on the screen the drawing lines with
the defined line thickness in Color and Tekla
grayscale color modes.

The Black and white color mode always shows
the printer line thicknesses on the screen, whereas
Color and Tekla grayscale color modes only show
the printer line thicknesses on the screen if the
Printer line widths switch is enabled.

When the option is on, the lines in color and
grayscale modes are shown with defined thickness.

When the option is off, the lines in color and
grayscale modes are shown with default thickness.

Printer line colors

Show line colors in the drawing. Selecting this
setting shows the changed drawing line colors
immediately in drawings.

Ghost outline

Show hidden objects in drawings as ghost outlines
in Color drawings. In Tekla grayscale and Black
and white drawings, hidden objects are not shown
even if Ghost outline is selected.

When the option is on, hidden lines are shown as
ghost outlines.

When the option is off, hidden lines are not shown.

Associativity symbol

Introduction to Tekla Structures user interface

Shows which drawing objects are associative and
automatically updated. Associativity symbols are
shown only when you select a drawing object, for
example a dimension.
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Objects that do not have valid association get a
ghost associativity symbol and a question mark.
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Option Description
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When the option is on, associativity symbols are
shown.

When the option is off, associativity symbols are
not shown.

Dimension creation
associativity

Activate the dimension creation associativity
functionality, which displays and allows you to
change the dimension associativity rule for each
dimension point separately during the manual
dimensioning of the drawing objects.

[ parie 3500160 F—

Drawing drag & drop

Activate or inactivate the drag-and-drop command
in drawings.

When the option is on, you can use drag-and-drop
when moving objects such as annotations, sketch
objects and grid lines without selecting the objects
or handles first.

When the option is off, you need to select the
objects or handles first before you can drag.

Toolbars

Use the toolbar switches to switch the selected toolbars on and off:

Snapping toolbar
Snap override toolbar
Selecting toolbar

Work plane handler toolbar

Model search toolbar
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+ Contextual toolbar

By default, the toolbars are located at the bottom of the screen.

See also

Snapping toolbar (page 62)

Selecting toolbar (page 58)

Change object properties using the contextual toolbar (page 48)
How to use the ribbon and the commands on the ribbon (page 40)

How to use Quick Launch to find commands, dialogs, and toolbars (page 43)

4.6 Selecting toolbar

The selection switches on the Selecting toolbar are special commands that
control which objects and object types you can select. For example, if you
select the entire model area but only the Select parts switch is active, only the
parts become selected.

Click the selection switches on the Selecting toolbar to switch them on or off.
rAmEDN/ 9EEAXOERS FIBe ¢ OAFBRQ a8 % o

By default, the Selecting toolbar is located at the bottom of the screen. If you
are unable to find the toolbar, click File --> Settings, and in the Toolbars list
ensure that the Selecting toolbar is selected.

Alternatively, you can control the selection switches with Quick Launch. Start
typing the name of the selection switch, for example, select, and click the
name of the selection switch on the search results list to activate the switch.

Main selection switches

The main selection switches control whether you can select components and
assemblies, or objects included in them. These switches have the highest

priority.
Switch Selectable objects Description

N Components When you click any object belonging
to a component, Tekla Structures
selects the component symbol and
highlights (but does not select) all
component objects.

A Component objects Objects created automatically by a
component can be selected.

Assemblies and cast When you click any object in an

units assembly or a cast unit, Tekla
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Switch

Selectable objects

Description

Structures selects the assembly or
cast unit and highlights all objects in
the same assembly or cast unit.

28

Objects in assemblies
and cast units

You can select single objects in
assemblies and cast units.

Other selection switches

The table below lists the remaining selection switches. Use these switches to
control which object types you want to select.

Switch Selectable objects Description

A Any objects Activate or deactivate all selection
switches. To activate or deactivate
switches one by one, hold down
the Ctrl key and click the selected
switches.
You can select all object types, except
for single bolts.

A Components You can select component symbols.

N Parts You can select parts, such as columns,
beams, or plates.

- Surface treatments and | You can select surface treatments and

surfaces surfaces.

o Points You can select points.

L X

/ Construction lines and | You can select construction lines and

circles circles.

S Reference models You can select entire reference
models.
This selection switch may affect the
speed of zooming and rotating in the
model.

o Grids You can select entire grids by

o selecting one line in the grid.

T Grid lines You can select single grid lines.

A Welds You can select welds.
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Switch Selectable objects Description
X Cuts and added material | You can select line, part, and polygon
cuts, fittings, and added material.
- Views You can select model views.
- Bolt group You can select entire bolt groups by
b= selecting one bolt in the group.
- Single bolts You can select single bolts.
o Rebar sets You can select rebar sets, and also
= reinforcing bar groups and single
reinforcing bars.
Rebar groups You can select bar groups in rebar
= sets, and also reinforcing bar groups
and single reinforcing bars.
- Single rebars You can select single bars in rebar
= sets, and also reinforcing bar groups
and single reinforcing bars.
Pour breaks You can select pour breaks.
|
I Planes You can select construction planes.
& Distances You can select distances that are
used in custom components or in
parametric modeling.
o Tasks You can select tasks in Task
manager.
. Switch direct modification on or off.
L
o Hide selected switches from the
toolbar.

Analysis model switches

The following switches can be used to select objects in an analysis model:

Switch Selectable objects

Description

Loads

I

You can select point, line, area,
uniform, and temperature loads.

Analysis parts

You can select analysis parts.
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Switch Selectable objects

Description

Nodes

You can select analysis nodes.

Rigid links

Yy

You can select analysis rigid links.

Selection switches in drawings

Similar selection switches are available in drawings:

Switch Selectable objects

Description

Any objects
N y 0D0J

Activate or deactivate all selection
switches. To activate or deactivate
switches one by one, hold down
the Ctrl key and click the selected
switches.

You can select all object types, an
entire group of dimensions, or an
entire grid.

Lines
Y

You can select drawing objects such
as lines, arcs, circles, rectangles,
polylines, polygons, and clouds.

Text
T

You can select any text in drawings.

Marks

You can select all kinds of marks

and associative notes in drawings.
This selection switch also selects weld
marks.

Parts
|

You can select parts, such as columns,
beams, and plates in drawings.

Section symbols
E Y

You can select section symbols in
drawings.

Welds

You can select welds in drawings. To
select weld marks, use the Select
drawing marks selection switch.

Views

You can select drawing views.

Dimensions

You can select drawing dimensions.
You can select an entire group

of dimensions by selecting one
dimension in the group.

Single dimensions

You can select single drawing
dimensions.
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Switch Selectable objects Description
m: Grids You can select grids in drawings.
£ Grid lines You can select single grid lines in
o drawings.
o Detail marks You can select details marks in
drawings.

" Plugins You can select custom plugins in
v drawings.

4.7 Snapping toolbar

Use the snap switches on the Snapping toolbar to control which positions you

can pick in the model or drawing to place objects. By using snap switches, you
can position objects precisely without having to know the coordinates. Use the
Snapping toolbar to activate snap switches and to access additional snapping
options.

Click the snap switches on the Snapping toolbar to switch them on or off.
B OO A X d N X ~ X 1 B B Autr Vewpla~  Outline plane @

By default, the Snapping toolbar is located at the bottom of the screen. If you
cannot find the toolbar, click File --> Settings, and in the Toolbars list ensure
that the Snapping toolbar is selected.

Alternatively, you can control the snap switches with Quick Launch. Start
typing the name of the snap switch, for example, snap, and click the name of
the snap switch in the search results list to activate the switch.

Main snap switches

The two main snap switches define whether you can snap to reference points
or any other points on objects, for example part corners. These switches have
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the highest snap priority. If both these switches are off, you cannot snap to
any positions, even if all the other switches are on.

Switch Snap Description Symbol
positions
H Reference You can snap to object Large
lines and reference points (points that
points have handles).
» Geometry You can snap to any pointon | Small
lines and an object.
points In drawings, you can use this
switch to snap to snapshot
overlays.

Snap switches and snap points

The snap symbols have two colors in the model:

+ Orange for model objects

+ Green for objects inside components

Make sure that you do not have too many snap switches on when snapping, as
it may easily lead to inaccuracies and errors in snapping. Be particularly careful

when you use the

Snap to any position snap switch.

Switch

Snap positions

Description

X

Points

Snaps to points and grid line
intersections.
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Switch

Snap positions

Description

End points

Snaps to end points of lines,
polyline segments, and arcs.

Centers

Snaps to centers of circles
and arcs.

In a drawing, when you want
to snap to the center point of
a circle that has been created
by using a polygon cut in the
model, set the advanced
option
XS_ADD_SNAPPING_SYMBOL_
TO_CIRCLES to TRUE.

Midpoints

Snaps to midpoints of lines,
polyline segments, and arcs.

Intersections

Snaps to intersections of
lines, polyline segments, arcs,
and circles, or to intersections
of an object face and part
edge line, a construction line
or a grid line.

Snapping on object faces
works only when the
rendering of parts is

set to Parts rendered/
Components rendered/
References rendered.

Perpendicular

Snaps to points on objects,
also on object faces, that form
a perpendicular alignment
with another object.

Snapping on object faces
works only when the
rendering of parts is

set to Parts rendered/
Components rendered/
References rendered.

i

Parallel

Snaps to points that are
parallel to grid lines, part
reference lines, and the edge
lines of existing objects or
reference objects.

Line extensions

Snaps to the line extensions
of nearby objects, and
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Switch Snap positions Description
reference and geometry lines
of drawing objects.

- Any position Snaps to any position.

X Nearest point Snaps to the nearest points
on objects, for example, any
point on part edges or lines.

v Lines Snaps to grid lines, reference
lines, and the edges of
existing objects.

Dimensions and mark lines, Snaps to annotation
¥ drawing | i i i
g layout items and geometries, drawing layout
drawing frames items and drawing frames.
Available only in drawings.

Snapping in drawings

In drawings, you can snap in positions in the same way as in the model. You
can also snap to orthogonal angles while placing drawing objects or sketching.

4.8 View status bar messages

Status bar is the area located at the bottom of the Tekla Structures main
window. Follow the instructions on the status bar when you use commands.
For example, when you are creating a part, the status bar will tell you how to
proceed and when to pick points.

Pick the first corner point for the plate. O S XYZOPan Current phase: 1, Phase 1 30 objects and 0 handles selected

1. Instructions and error messages

The status of Ortho (O), Smart select (S), Drag & drop (D) and coordinate
locks (X, Y, Z).

o

The level in assembly or component hierarchy (0-9)

3
4. The middle mouse button mode (Pan or Scroll)
5. The current phase

6

The number of selected objects and handles

See also
Basic settings in the File menu (page 51)
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4.9 Icons on the Quick Access Toolbar

Quick Access Toolbar provides shortcut icons to the commonly used
commands. The toolbar is located on top left corner of the screen.

If needed, you can customize the Quick Access Toolbar and add the
commands of your choice to it.

Ilcon

Description

Save (page 20) changes to the current model file.

Undo the last action.

Redo the actions previously undone.

IR

Open the Undo history (page 66) dialog. The dialog lists the
commands you have run and the modifications you have done.
Use the list to undo or redo several commands or modifications at
one go.

3

This icon is visible if you use Tekla Model Sharing.

Read in other users' model changes from the sharing service. Only
the changed data is read in.

This icon is visible if you use Tekla Model Sharing.

Write out your model changes to the sharing service. Only new or
changed data is written out.

The icon is visible if you use Tekla Model Sharing.

Show read in changes. After you have read in, a list of model
changes is displayed.

See also

Introduction to Tekla Structures user interface (page 39)

4.10 Undo modeling and drawing changes

The Undo history list helps you to check which commands and modifications
you have done and undone, and to keep track of the changes. By selecting

a command or an action in the Undo history dialog, you can undo or redo
several commands at one go, and thus go back and forth in the model history.
Undo history is available both in the modeling and in the drawing mode.
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How to use Undo history

To open the Undo history dialog, click the © button on the Quick Access
Toolbar, next to the Undo and Redo buttons. Alternatively, use Quick Launch

to open the dialog.

To

Do this

Undo commands

Click any row on the list.

If the undo operation takes a long
time, Tekla Structures highlights the
clicked row to show what was
selected.

All the modifications you have done
after the selected command are
undone. The modifications you have
undone have a dark gray background
color in the list.

Redo previously undone commands

Click any row with a dark gray
background color in the list.

All the modifications you have done
before the selected command are
redone.

Add a bookmark

Move your mouse pointer over any

row. A bookmark icon  is shown.

Click the bookmark icon to mark
certain commands.

Use the bookmarks to mark
important commands or actions. You
can later return to these commands
or actions if the changes in the model
are not satisfactory.

To remove a bookmark, click the

bookmark icon © again.

The Undo history dialog

+ lists the commands you have run and modifications you have done,
starting from the top of the list. The latest commands and modifications

are at the bottom of the list.

+ updates constantly according to the changes you make in the model or in

the drawing.

+ creates a hierarchy for some of the used commands. The hierarchy is
created when you first run a command, then you undo some commands to
a certain point in the list, and run another command.
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The hierarchy is marked with an arrow in the list. You can undo or redo
commands at any point in the hierarchy, making it possible to undo
commands that you have previously redone.

This means that after you have undone a command, you can continue
working with the model, and you still have the option to go back to the

commands you have used first.

The Undo history list is cleared when you

* save a model

+ open or close a drawing

+ synchronize Organizer with the model

* read in or write out model changes using Tekla Model Sharing

« use CIS/2 or SDNF import commands.

See also
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4.11 Default keyboard shortcuts

Tekla Structures contains a large number of keyboard shortcuts that you can
use to speed up your work.

If you want to assign new shortcuts or change the default shortcuts, you can
customize the keyboard shortcuts (page 129).

Common commands

Command Keyboard shortcut

Help F1

Help: when tooltip is open Ctrl+F1

Open Recent models list Ctrl+O

Create new model Ctrl+N

Save model Ctrl+S

Delete Del

Open properties Alt+Enter

When an object is selected, the

properties are opened either in the

property pane or in a dialog.

Undo Ctrl+z
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Command Keyboard shortcut
Redo Ctrl+Y
Interrupt Esc
Repeat last command Enter
Show/hide contextual toolbar Ctrl+K
Switch direct modification on/off D
Quick Launch Ctrl+Q
Open Advanced options dialog Ctrl+E
Open Applications & components | Ctrl+F
catalog side pane
Open Keyboard shortcuts dialog Ctrl+Shift+C

Rendering options

Command Keyboard shortcut
Parts wireframe Ctrl+1
Parts shaded wireframe Ctrl+2
Parts grayscale Ctrl+3
Parts rendered Ctrl+4
Show only selected part Ctrl+5
Components wireframe Shift+1
Components shaded wireframe Shift+2
Components grayscale Shift+3
Components rendered Shift+4
Show only selected component Shift+5
References wireframe Ctrl+Shift+1
References shaded wireframe Ctrl+Shift+2
References grayscale Ctrl+Shift+3
References rendered Ctrl+Shift+4
Show only selected reference Ctrl+Shift+5
Building hierarchy wireframe Ctri+Alt+1
Building hierarchy shaded wireframe | Ctrl+Alt+2
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Selecting objects

Command Keyboard shortcut
Switch rollover highlight on/off H
Select all selection switch F2
Select parts selection switch F3
Select rebar sets selection switch Alt+Q
Select rebar groups selection switch | Alt+W
Select single rebars selection switch | Alt+E
Select all objects in the model Ctrl+A
Select previous objects Alt+P
Select assembly Alt+object
Add to selection Shift
Toggle selection Ctrl
Selection filters Ctrl+G
Hide object Shift+H
Snapping

Command Keyboard shortcut
Snap to reference lines/points F4
Snap to geometry lines/points F5
Snap to nearest points F6
Snap to any position F7
Switch Ortho on/off (o)
Relative coordinate input R
Absolute coordinate input A
Global coordinate input G
Cycle forward through the available | Tab
snap points
Cycle backwards through the Shift+Tab
available snap points
Switch coordinate lock X, Y or Z on/off | X, Y or Z
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Copying and moving objects

Command Keyboard shortcut

Copy Ctrl+C
Paste Ctri+v
Move Ctrl+M
Switch smart select on/off S

In the property pane: Shift+C
Copy to clipboard

In the property pane: Shift+V
Paste from clipboard
Viewing the model

Command Keyboard shortcut

Open model views Ctri+l
Switch between 3D/plane view Ctrl+P
Switch between views Ctrl+Tab
Updated window Ctri+U
Zoom original Home
Zoom previous End

Zoom in Page Up
Zoom out Page Down
Zoom selected Shift+Space
Rotate using mouse Ctrl+R

Rotate using keyboard

Ctrl+arrow keys
Shift+arrow keys

Set view rotation point Vv
Rotate once Shift+R
Rotate continuously Shift+T
Switch view rotation on/off F8
Pan P
Switch middle button pan on/off Shift+M
Move right arrow keys
Move left
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Command

Keyboard shortcut

Move down
Move up
Center by cursor Insert
Use to center the model on a
particular point.
Fly Shift+F
Create clip plane Shift+X
Switch fullscreen on/off F11
Checking the model

Command Keyboard shortcut
Inquire object Shift+l
Measure distance F
Create report Ctrl+B
Open Phase manager Ctrl+H
Create AutoConnections Ctrl+)
Rebar display options

Command Keyboard shortcut
Leg face visibility Alt+1
Guideline visibility Alt+2
Property modifier visibility Alt+3
Splitter visibility Alt+4
End detail modifier visibility Alt+5
Rebar dimension visibility Alt+6
Color rebar groups Alt+7

Part position options

These keyboard shortcuts work for both native Tekla Structures parts as well

as for analysis parts.

Command

Keyboard shortcut

Part position up

Alt+arrow up
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Command

Keyboard shortcut

Part position down

Alt+arrow down

Part position left

Alt+arrow left

Part position right

Alt+arrow right

Part rotation clockwise 90 degrees

Note that this command is not
available for analysis parts.

Alt+space

Drawings
Command Keyboard shortcut
Open Document manager in model | Ctrl+L
Open Document manager in Ctrl+O
drawing mode
Print drawings Shift+P

Open next drawing

Ctrl+Page Down

Open previous drawing

Ctrl+Page Up

Associativity symbol Shift+A
Set next drawing color mode B
Ghost outline Shift+G
Add orthogonal dimension G

Add free dimension F

Open any drawing after creating the | Ctrl+Shift
drawing

In Document manager: Open user- | Alt+U
defined attributes

In Document manager: Add to Ctrl+M
Master Drawing Catalog

In Document manager: Revision Ctrl+R
handling

In Master Drawing Catalog: Select all| Ctrl+A
In Master Drawing Catalog: Create | Alt+A
drawings for all parts

In Master Drawing Catalog: Create | Alt+C
drawings

Set UCS origin U

Set UCS by two points Shift+U
Toggle orientation Ctri+T
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Command

Keyboard shortcut

Reset current

Ctri+1

Reset all

Ctrl+0

4.12 Change the language of Tekla Structures user
interface
You can change the language of the Tekla Structures user interface at any

time.

1. On the File menu, click Settings --> Change language.

2. Select a language from the list.

You have the following options. The three-letter language codes that are
given in parentheses are used in some language-dependent file and folder
names.

Chinese - simplified (chs)
Chinese - traditional (cht)
Czech (csy)

Dutch (nld)

English (enu)

French (fra)

German (deu)

Hungarian (hun)

Italian (ita)

Japanese (jpn)

Korean (kor)

Polish (plk)

Portuguese (ptg)
Portuguese - Brazilian (ptb)
Russian (rus)

Spanish (esp)

3. Click OK.

Restart Tekla Structures for the change to take effect.
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4.13 Take screenshots

A screenshot is an image of a model or drawing view. You can use screenshots
in posters, brochures, or other material to show projects carried out using
Tekla Structures.

By default, the screenshots are saved in the \screenshots folder under the
current model folder with the name snap xx.png.

Take a screenshot of a model
You can take screenshots of model views.

1. Open a model and adjust the model view according to your needs.

For example, hide the work area box if you do not want to show it.

2. Onthe View tab, click ﬂ Screenshot --> Screenshot.

3. If you have multiple views of the model, click Pick view and select the
view to take the screenshot from.

4. To modify the settings, click Options.
a. Define the width, height, and DPI of the screenshot.
b. Click OK to save the changes.

5. Define a name and location for the screenshot.

a. Select Print to file and enter a descriptive name for the screenshot in
the File name box.

You can also change the whole path. If you do not want to do this, you
can keep the default values for the path and the file name.

6. Click Show with associated viewer to show the screenshot in an
application that is by default associated with this file type.

7. Click Capture.

Take a screenshot of a drawing
A drawing screenshot is an image of an open drawing with or without borders.

1. Open a drawing and adjust the drawing view according to your needs.

For example, delete unnecessary marks or dimensions, and hide
unnecessary parts.

2. Onthe Views tab, click m Screenshot --> Screenshot.
3. Do one of the following:
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+ Select View to take a screenshot of the open drawing with window
borders

+ Select View without borders to take a screenshot of the open drawing
without window borders.

4. Under the preselected Print to file option enter a descriptive name for
the screenshot in the File name box.

You can also change the whole path. If you do not want to do this, you can
keep the default values for the path and the file name.

5. Click Show with associated viewer to show the screenshot in an
application that is by default associated with this file type.

6. Click Capture.

Save a screenshot in bitmap format

By default, screenshots are created as Portable Network Graphics (. png) files.
You can also save a screenshot in bitmap (.bmp) format to use it, for example,
as a custom component thumbnail. Note that the bitmap file size is much
larger than when saving as PNG.

1. On the Views tab, click EI Screenshot --> Screenshot.
2. Select Place on clipboard.

3. Click Capture.
4

Paste the screenshot in your graphics editor and save it in .bmp format.

NOTE The software that you use to open the screenshot may have a limit for the
number of pixels.

Screenshot settings
Use the Screenshot dialog to view and modify the screenshot settings.

The following options are available in model views and in drawings.

Option Description
View name Shows the selected view name.
View Includes the view content and window

borders in the screenshot.

Not available in model views.
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Option

Description

View without borders

Includes only the view content in the
screenshot.

Not available in model views.

Rendered view

For high resolution screenshots from
model views. The Options button
displays the Screenshot Options
dialog.

Not available in drawings.

Place on clipboard

Places the screenshot on the
clipboard.

Not available in drawings.

Print to file

Saves the screenshot to a file.

The following screenshot options are only available in model views:

Option

Description

Final width

The width of the screenshot.

The units depend on the settings in
File menu --> Settings --> Options
--> Units and decimals.

Final height

The height of the screenshot.

The units depend on the settings in
File menu --> Settings --> Options
--> Units and decimals.

DPI

The pixel density (DPI) of the
screenshot.

There are limitations to pixel density.
You can change the DPI using a
graphics editor.

White background

Uses white background.

Smooth lines

Uses smooth lines to decrease jagged
edges.

Line width

Sets the line width.
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5 Work with model object and
drawing object properties

When you start creating model or drawing objects in Tekla Structures, most
commands ask you to pick points to place the objects in the model or in the
drawing. The objects are typically then created by using a predefined set of
properties.

The object properties can be viewed and further modified, typically by using
the property pane (page 78). Alternatively, you can also use contextual
toolbar (page 48) to modify many of the object properties. Some properties,
such as analysis part properties, are modified by using dialogs (page 97).

The property pane or contextual toolbar can be used for copying properties
from one object to another. Additionally, you can define the properties for
each object type you plan to create before you start modeling or creating
drawings. You can save and load these properties (page 94) in the property
pane or in the dialogs.

5.1 View and modify object properties in the property
pane

Tekla Structures shows the properties of different model objects and drawing
objects in the property pane, which is a side pane window.
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Note that you can have only one property pane window open at a time. This
means that you can view the properties of only one object type at a time.

£} Steel beam 017 X
-‘ -

Q =
¥ General
Mame BEAM
Profile HEA300
haterial S235JR
Class G -
Finizh

» Numbering series
P Position

» End offset

» IFC export

¢ More

Show all properties

You can customize the property pane (page 114). For example, you can
organize the settings as you wish, or hide or remove the settings you do not
need.

To quickly modify the properties of a few objects only, use the contextual
toolbar (page 48).

Open the property pane
To open the properties in the property pane:

+ If the property pane is closed: double-click a model or a drawing object, or

click the Properties o button in the side pane.
+ If the property pane is open: select a model object or a drawing object.
* Hold down Shift and click a command on the ribbon.

+  Double-click a command on the ribbon.
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Modify the properties of a model object or a drawing object

1. To start modifying the properties, double-click a model object or a
drawing object.

The property pane opens and shows the current properties of the object.
2. Modify the properties as needed.

Tekla Structures highlights the modified properties in yellow in the
property pane.

If you enter a value that is not valid, Tekla Structures indicates the error
with a red frame and an exclamation mark.

3. To clear the selection, click the check marks next to each setting to remove
them.

You can clear the check marks one by one, or select a whole section and
all its properties.

{3 Steel column (1 selected) o X
..‘ -

Q =
¥ General v
Marme COLURMN
Profile HEAZED L
Material 523510
Class . Y A

You can use the Select All and Select None switches at the bottom of the
property pane to select all the changes or to clear all the changes.

4 Select All | None

4. When you are ready with the modifications, click Modify to apply the
changes.

Tekla Structures modifies the object and uses the current properties the
next time you create an object of the same type, if you have selected the
Set default values automatically option in Property pane settings.

5. If you want to create an object using the standard values instead of the
values you just applied, load the standard file first.
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4 | standard * | B

standard
MyProperties

Note that if you use the contextual toolbar (page 48) or direct modification
to modify an object, the current properties do not change and are not
automatically applied when you create the next object of the same type.

Modify the properties of multiple model objects or drawing
objects

You can select several model or drawing objects in the model or in the
drawing, and change their properties at one go. The selected objects can be
of the same object type, such as steel columns or drawing sketch objects, or
they can be of different object types, but the property pane shows only the
properties that are common for all the selected objects.

1. Select the objects in the model or in the drawing.
Property pane shows the properties for the selected objects.

The settings where the values differ have the text Varies, and the values
or options are shown in a list. If there are no common properties, the
property pane is empty.

£} Steel column (5 selected) U X
_‘ -
Q =
¥ General
Marme COLURM
Profile -

Iaterial S235JRG2
Finish
Class —

2. Modify the properties as needed.

You can select a value from a list or enter a new value for a property, in
the same way when only one model or drawing object is selected.

Tekla Structures highlights the modified properties in yellow.
3. Click Modify.

The selected properties are modified.
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To check which objects you have selected in the model or in the drawing, click

the Object type list 4 button to open the list of the selected objects.

m Steel column (15)

ﬁ Steel beam (63)

I Concrete column (14)

Ii Concrete panel (€)

\

> Concrete slab (1)

+

%" Pad footing (3)

Eﬂ Strip footing (8)

Hi

®+ Compeonent (71)

Select all

To modify the object selection, hold down Ctrl, and in the list click the object
types that you want to exclude or include in the selection.
The content of the property pane changes according to your selection.

If you want to select all the objects, click the Select all button.

Modify the properties of drawing annotation objects in
visual editor

The drawing property pane contains a visual editor for editing some of the
drawing annotations, such as dimension tags, view labels, associative notes,

and most mark types. You can see the resulting annotation as you create it,
which makes the editing of the annotation objects much easier.

1. To start modifying the properties, double-click an annotation object in an
open drawing.
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The property pane opens and shows the current properties of the
annotation object. The properties are located in boxes called containers.
Below is an example of the section mark visual editor.

A ¥ Section label
Section name A

Property file -~

 Properties RIS ™ End

S 1- _____ D Section name
| ‘Section namé
I: b b s e s e el e e
I I
! !
D ' ]
10010 + [ 100 %
¥ Font
A Font color [ -
Font Arial -

+ To load predefined contents for the annotation object, select a
property file from the Property file list.

+ To show either the property name or the property value in the preview,
click the Properties or Values button. These buttons are only available
when you are modifying an annotation.

*  The % button shows the current zoom level in the preview. You can
zoom in or out by scrolling the middle mouse button. Click the %
button to zoom to the best fit.

+ In section marks, to indicate which end of the cutting line you want to
work with, click Start or End.

2. To add an elementin a container, click a container, and then click the +
New element button.

+ If the container is empty, the element list opens automatically when
you click the container.

* In most of the visual editors, you can drag elements and containers.
The dimension tag editor only allows you to drag elements inside a
container.

+  When dragging elements from different rows, the editor automatically
organizes them into a single row, maintaining a clear order from top to
bottom and left to right.

* To delete an element or a container, click the red delete button % in
the upper-right corner of the element or container.
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+ To search for elements, use the search box that opens when you
open the element list. The available elements vary according to the
annotation object type.

« To add a user-defined attribute, template attribute, or a custom
property, select the attribute from the list of available attributes. To
add a hidden user-defined attribute, type the name in the search box
and press Enter.

* To add new containers in section marks, detail marks, or view labels,
click the ' New container button. You can add up to five containers.

+ Indimension tags, you first need to click a tag container to be able to
add elements in the tag in the tag editor. When a dimension tag has

some content, the container icon changes to ® | You can also type
text directly in dimension tags, the text will be shown as it is in the
container.

3. Modify the representation of the whole annotation object or an individual
element. For example, modify the font styles and frames.

Modify other annotation object properties.
5. Click Modify.

Show only frequently used properties in the property pane

You can control separately for each object type which properties are shown
in the property pane. Thus, you can create your favorite sets of properties for
every object type, and make the property pane less cluttered by hiding the
properties that are not needed frequently.

Customize the property pane layout (page 114) using the Property pane
editor, and mark each property as frequently or infrequently used. When
using the property pane, you can select between showing only the frequently
used properties or all the properties of one object type.

After you have marked the properties as frequently or infrequently used

in the Property pane editor, the Show fewer properties or the Show all
properties button is activated at the bottom of the property pane. Use the
buttons to switch between showing the frequently or the infrequently used
properties.

1. To show only frequently used properties in the property pane, customize
the property pane layout of the selected object type.

2. Inthe model or in the drawing, double-click an object to open the
property pane.
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Only the properties that are marked as frequently used are shown. Other
properties are hidden.

If all the properties are marked as frequently used, the Show fewer
properties button is not available.

3. Ifyou want to see all properties, click the Show all properties button.

¥ More

UDAs User-defined attributes

Show all properties

4. If you want to switch back to only frequently used properties, click the
Show fewer properties button.

NOTE If you close Tekla Structures or switch between modeling mode
and drawing mode, Tekla Structures shows the frequently used
properties in the property pane.

You have to click the Show all properties button to show all the
properties.

Search in the property pane

Use the search to find the needed properties or the user-defined attributes
(UDAs). Enter the search term in the search box in the property pane.

P :
|

If you have several different object types selected in the model, the search
finds the properties that are common to the all selected object types. UDAs
that match to the search criteria are shown even if they have not been added
to the property pane layout.

If you enter a single asterisk * in the search box, all properties and UDAs
available for the selected object type are shown. You can then easily enter a
value for a property or for an UDA, even if the property or the UDA is not
visible in the property pane by default.

Work with model object and drawing object 85 Copy properties from another object in the
properties property pane



5.2 Copy properties from another object in the property
pane

You can use the property pane to copy properties between model or drawing
objects.

In the property pane, both in modeling or in drawing mode, you can either

+ copy properties from a selected object first to the Tekla Structures
clipboard and then paste the properties from the clipboard to the selected
objects.

Use the Copy to clipboard ® ommand.

Copying properties to the clipboard is useful if you need to do a lot of
repeated modifications to different types of objects in a sequential work
flow. Tekla Structures saves the copied properties of every object type to
the clipboard, independently of each other, and you can later paste the
properties to other objects of the corresponding object type.

You can copy all the properties of an object to the clipboard, or select
separately which properties to copy.

The object from which the properties were copied and the object to which
the properties are copied need to be of the same object type.

+ copy properties from a selected object straight to another object.

Use the Copy to other object 8 command.

You can copy all the properties of an object straight to another object, or
select separately which properties to copy.

You can copy properties between objects as long as both of the objects
have the same property available.

To quickly copy properties to a few objects only, use the contextual toolbar
(page 48).

Use Copy to clipboard for copying object properties

Using the Copy to clipboard command in the property pane, you can apply
repeated modifications to objects in a sequential workflow. This is particularly
useful in drawing mode when you need to modify different types of objects
across multiple drawings, such as part marks, reinforcement objects, or
dimensions. For example, you can select objects in the current drawing or

in any other drawing, copy the properties to the clipboard, and paste the
properties to objects in the same drawing or even in other drawings. The Copy
to clipboard command is also available in modeling mode.

1. Select the object in a model or in a drawing that you want to copy
properties from.
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To Do this

Copy all the properties of the selected | Click the Copy to clipboard L
object to the clipboard. button at the bottom of the property
pane, or press Shift+C.

All properties of the selected object
are copied to the clipboard, and a

smallicon '® appears in front of
every property value box.

To clear the selection:
+ For all properties: click the Copy

to clipboard ® button again, or
press Shift+C again.

+ For asingle property: click the

small icon '® in front of the
property value box to clear the
selection.
Copy individual properties of the Place the mouse pointer close to a
selected object to the clipboard. property and click the small gray icon

|:| that appears in front of the
property value box.

The selected property is copied to the
clipboard and the gray icons turns to

black ®

In double properties, both of the
property values can be copied

separately [ =[],

To copy several properties, hold down

Shift and click the small icon |:|
in front of the property value boxes
you want to copy to the clipboard.

To clear the selection, click the small

icon '® in front of the property
value boxes to clear the selection.

2. Select the objects to which you want to copy the properties.

The objects need to be of the same object type as the one which the
properties were copied from.
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Place the mouse pointer on the Paste B button. The Paste button is
visible only if there is something to be pasted from the clipboard to the
object type in question.

In the property pane, Tekla Structures highlights the properties in yellow
that are about to change.

Click the Paste B button, or press Shift+V.

The properties in the property pane change accordingly and the selected
objects are modified.

Note that all user-defined attributes (UDAs) are copied with the object
properties when you use the Copy to clipboard command, also those
which are not visible in the property pane.

Unique user-defined attributes (unique attribute)are not copied with
the object properties.

Note the following

Tekla Structures saves the copied properties of every object type to the
clipboard, independently of each other, and you can later paste the
properties to objects of the corresponding object type.

The properties will stay on the clipboard until you copy new properties.
Note that the clipboard is cleared if you restart Tekla Structures.

Copy to clipboard works only in Tekla Structures, and it is not the same as
the Windows clipboard.

If you select multiple objects to paste the copied properties to, use the
Object type list to select the appropriate object types for pasting. The
Paste button is visible only if there are properties on the clipboard that can
be pasted to the selected object type.

You cannot paste properties to objects which are of different type than the
object from where the properties were copied from.

Use Copy to other object for copying object properties

Using the Copy to other object command in the property pane, you can copy
properties from a selected object straight to another object, without storing
the properties on the clipboard. First, select the object to copy properties from,
and then select the objects you want to copy the properties to.

1.

Select the object in a model or in a drawing that you want to copy
properties from.

2. Click the Copy to other object & button at the bottom of the property
pane. In the model, the mouse pointer changes into a paintbrush.
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In the property pane, Tekla Structures highlights the properties in yellow
that are to be copied. Tekla Structures automatically selects the same
properties as when you previously copied properties of an object of the
same type in the same model.

3. Select or clear the check marks next to the properties to
indicate which properties you want to copy.

You can clear the check marks one by one, or select a whole section and
all its properties, or use the Select All and Select None switches at the
bottom of the property pane. If you use the Select None switch, all check
marks will be cleared the next time you start the Copy to other object
command.

4. Select the objects you want to copy properties to.
You can use area selection to quickly select a large number of objects.
In the property pane, Tekla Structures highlights the properties to be
v

copied in yellow
If needed, clear the check marks if you do not wish to copy some of the
properties.

5. Click Modify or press Enter. In the model, the mouse pointer returns to
normal.

Note that all user-defined attributes (UDAs) are copied with the object
properties when you use the Copy to other object command, also those
which are not visible in the property pane.

Unique user-defined attributes (unique attribute)are not copied with
the object properties.

TIP To copy properties to multiple objects in a row, double-click the &
Copy to other object button to keep the Copy to other object
command running. Click Modify after each selected object. The
mouse pointer remains in the paintbrush mode until you press Esc

or click ' again.

5.3 Modify the property pane settings

You can modify and customize the content of the property pane. You can do
some of the modifications directly in the property pane, in the Property pane
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settings = . More thorough customizations (page 114) of the property pane
layout are done in the Property pane editor.

Switch between automatic and manual applying of
properties in the property pane

When you modify object properties in the property pane, you can switch
between automatic and manual applying of properties. This means that you
can select whether only the selected object is modified, or whether Tekla
Structures also uses the current values the next time you create an object of
the same type.

You can switch between manual and automatic applying of properties at any

time in the Property pane settings = by selecting the Set default values
automatically option. The option is not dependent on the selected object
type.

Enable automatic applying of properties (the default option)
1. Select an object in the model or in the drawing.

2. Click the Property pane settings — button in the property pane to
open a dropdown menu.

3. Ensure that the Set default values automatically option is selected.

When the Set default values automatically option is selected, Tekla
Structures automatically uses the current values the next time you create
an object of the same type.

Change the properties as needed.

5. Click Modify.
Tekla Structures modifies the object and uses the current values the next
time you create an object of the same type.

Enable manual applying of properties

1. Select an object in the model or in the drawing.

2. Click the Property pane settings — button in the property pane to
open a dropdown menu.

3. Ensure that the Set default values automatically option is not selected.
A Set as default button appears at the bottom of the property pane.

Note that if you have selected multiple objects in the model, the Set as
default button does not appear.

4. Change the properties as needed.
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5. Select how to proceed.
« To modify only the selected object, click Modify.

« To modify the selected object and to use the current values the next
time you create an object of the same type, click the Set as default
button and then click Modify.

« To use the current values the next time you create an object of the
same type but not to modify the selected object, click the Set as
default button.

Depending on your actions, Tekla Structures either modifies the selected
object or creates the next object of the same type using the current
values.

Control the visibility of the Copy to clipboard and Copy to
other object buttons in the property pane

You can control in the Property pane settings = which methods for
copying the object properties are visible in the property pane.

If you do not need both of the copying methods, Copy to other object and
Copy to clipboard, you can make the property pane less cluttered and hide
the option that is not needed. You can control the visibility of the buttons
separately in modeling mode and in drawing mode.

1. Click the Property pane settings — button to open a dropdown menu.

The options Copy properties to object and Copy properties to
clipboard control the visibility of the corresponding buttons in the
property pane.

2. Ensure that the option you wish to use is selected.
The option that is not selected is hidden in the property pane.

Control the visibility of property groups in the property
pane

You can control in the Property pane settings = which property groups
are visible in the property pane, without customizing the property pane layout
(page 114).

1. Click the Property pane settings — button to open a dropdown menu.

2. Ifyou want to expand or collapse all the property groups (page 116), click
Expand all or Collapse all.
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3. In modeling mode:

You can select between showing only those properties that have a value,
or showing the property groups that you have defined to be visible.

+ Show properties that have a value: property pane shows all
the properties and user-defined attributes (UDAs) for which you or
someone else has entered a value. UDAs with a value are listed in the
Additional matches property group.

Property Visibility

Properties of text type Properties are visible if they contain
text, meaning that they have a value.

Properties of other type Properties are always visible.

Composite properties Properties are visible if any of the
properties in the composite property
has a value.

UDAs of text type UDAs are visible if they contain text,

meaning that they have a value.

UDAs of other type UDAs are always visible if something
else than an empty value is selected.

UDAs of other type such as integer, UDAs are visible if they contain a
float, and date value.

The Show properties that have a value option is common for all
object types. For example, if you select a steel beam in the model and
use the Show properties that have a value option, and then select
a concrete beam in the model, only properties that have a value are
shown for the concrete beam.

« Show properties based on group visibility: property pane shows all
the property groups that are marked to be visible. Property groups

with the € icon are visible. Property groups with the # icon are
hidden. Click the property group names to change the visibility. You
can show and hide only the main level property groups, not nested
groups.

The Show properties based on group visibility option is common
for all object types. If different object types have property groups of
the same name, the visibility of a property group is adjusted for all
the object types. For example, if you select a steel beam and hide
the Position property group, and then select a concrete beam, the
Position property group is hidden for the concrete beam as well.

The default visibility of property groups can be defined in the Property
pane editor. Note that the changes in the visibility settings in the
property pane override the default settings done in the Property pane
editor.

4. Indrawing mode:
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Show and hide property groups. Property groups with the € icon are

visible. Property groups with the #* icon are hidden. Click the property
group names to change the visibility. You can show and hide only the main
level property groups, not nested groups.

Showing and hiding of property groups is common for all object types.
If different object types have property groups of the same name, the
visibility of a property group is adjusted for all the object types.

The default visibility of property groups can be defined in the Property
pane editor. Note that the changes in the visibility settings in the
property pane override the default settings done in the Property pane
editor.

Where the property pane settings are saved

When you click the Property pane settings — button and select an
option, the current settings are saved to the PropertyPaneSettings.xml
or to the PropertyPaneDrawingSettings.xml file. The files are

located inthe . .\Users\<user>\AppData\Local\Trimble\Tekla
Structures\<version>\UI\PropertyPane\ folder.

If you do not change the settings, the PropertyPaneSettings.xml or the
PropertyPaneDrawingSettings.xml file is not created.

The settings in the file are:

* FilterMode: ByData for Show properties that have a value

* FilterMode: ByGroups for Show properties based on group visibility

* AutoApply: True when Set default values automatically is selected

* AutoApply: False when Set default values automatically is not selected
* ShowCopyProperties: True when Copy properties to object is selected

* ShowCopyToClipboard: True when Copy properties to clipboard is
selected

The PropertyPaneSettings.xml and the
PropertyPaneDrawingSettings.xml files are read when Tekla Structures
is started and a model is opened.

If the settings in the PropertyPaneSettings.xml and the
PropertyPaneDrawingSettings.xml files are customized, the company
administrators can distribute the customized property pane settings to other
users in the company.

1. Create a sub-folder called \PropertyPane either in a model, project
(xs_PROJECT), firm (xS FIRM) or environment (XS SYSTEM) folder.

Work with model object and drawing object 93 Modify the property pane settings
properties



2. Place the PropertyPaneSettings.xml and the
PropertyPaneDrawingSettings.xml file to the \PropertyPane
folder.

3. Restart Tekla Structures.

The property pane settings in

the . .\Users\<user>\AppData\Local\Trimble\Tekla
Structures\<version>\UI\PropertyPane)\ folder has the highest priority,
and after that Tekla Structures uses the default search order.

If the PropertyPaneSettings.xml and the
PropertyPaneDrawingSettings.xml file is placed in several different folder
locations, Tekla Structures reads the settings from different folders and
merges them.

5.4 Save and load object properties in the property pane
or in the dialogs

The property pane and many dialogs have the possibility to save the property
information in property files. You can load these saved properties later on
when you create new objects.

For example, you can define the properties for each object type you plan to
create before you start modeling, and then use these user-defined property
files when you are creating new objects. Tekla Structures stores the user-
defined property files, including the properties of sub-dialogs, in the current
model's \attributes folder.

You can save and load object properties either in the property pane or in a
dialog, depending on the object type.

Save and load properties in the property pane

Use the property pane to save and load the properties of model or drawing
objects.

1. Click a model or a drawing object to view the current properties in the
property pane.

2. Inthe property pane, modify or enter the properties (page 78) you want to
save.

3. Inthe box next to the ™ button, enter a name for the property file in
which the properties are saved.

For example, MyProperties.

4. Click ® to save the properties in the property file.
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The property file is now saved in the current model folder:

¥ Concrete slab o X
« | MyProperties | &

I MyProperties | Q

5.  When you want to load the saved properties, select the property file from
the list.

« If you have several property files on the list, start typing the desired
property file name to filter the list, then press Enter to select it.

« If you select an object in the model or in the drawing and load
a property file in the property pane, the properties and the user-
defined attributes (UDAs) are loaded immediately. Changed values are
highlighted in yellow in the property pane. Click Modify to apply the
new values.

If there are changes only in the UDA values in the UDA dialog and not
in the values in the property pane, the Modify button in the property
pane does not become active. Click Modify in the UDA dialog to active
the UDA values.

+ If you start an object creation command and load a property file in the
property pane, the properties and the user-defined attributes (UDAs)
are used immediately and Tekla Structures creates the object using the
loaded values.

NOTE If the UDA dialog is open when you load a property file in the
property pane, the UDA dialog updates and shows the values
of the UDAs that are saved in the property file. However, if you
first select an object and load a property file and only then open
the UDA dialog, the dialog shows the UDA values of the selected
object.

To check which UDA values are saved in a property file, you need
to open the UDA dialog first, or load the property file again after
opening the UDA dialog.

6. If you want to make changes to an existing property file:
a. Load the property file you want to change.
b. Modify the properties.

c. Click H.
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Tekla Structures saves the changes in the property file shown in the
list, overwriting the old property file.

Tekla Structures uses the new properties the next time you create an
object of the same type.

If you want to create an object using the standard values instead of
the saved properties, load the standard file.

Save and load properties in a dialog

Use this method with properties that are displayed in a traditional dialog. For
example, with view properties.

1.
2.
3.

Open the properties dialog.
In the dialog, modify or enter the properties you want to save.

In the box next to the Save as button, enter a name for the property file in
which the properties are saved.

For example, MyProperties.
Click Save as to save the properties in the property file.

The property file is now saved in the current model folder:

\EI \ﬂl standard -

standard

Attributes | PdMyProperties

When you want to load the saved properties, select the property file from
the list, and click Load.

If there are several property files on the list, start typing the desired
property file name to filter the list, then press Enter to select it.

If you want to make changes to an existing property file:
a. Load the property file you want to change.

b. Modify the properties.

c. Click Save.

Tekla Structures saves the changes in the property file shown in the
list, overwriting the old property file.

Remove existing properties

You can remove user-defined property files manually by removing them from
the model's \attributes folder.

Work with model object and drawing object 96 Save and load object properties in the property

properties pane or in the dialogs



1. Remove the selected property file from the model's \attributes folder.

The property files may have different file name extensions, depending on
their type.

2. Restart Tekla Structures.

5.5 View and modify object properties by using dialog
boxes
You can use dialogs to view and modify the properties of various objects, such
as analysis part properties, in Tekla Structures.

NOTE Model and drawing object properties, such as part properties, are modified in
the property pane (page 78), not using dialogs.

The following table lists some common buttons that can be found in the Tekla
Structures dialogs.

Button Description
OK Saves the properties and closes the dialog. Tekla Structures
uses these properties the next time you create an object of
this type.
Apply Saves the properties without closing the dialog. Tekla

Structures uses these properties the next time you create
an object of this type.

Modify Modifies the selected objects using the current properties of
the dialog.
Get Fills the dialog with the properties of the selected object. If

several objects are being selected, Tekla Structures takes the
properties randomly from one of them.

Switches all check boxes in the dialog on and off.

Cancel Closes the dialog without saving the properties or modifying
objects.

Save Saves the properties in the file shown in the list.

Load Loads the previously saved properties to the dialog. Tekla

Structures also loads the properties of sub-dialogs, even if
they are not open. Select the name of the properties file you
want to use.

Save as Saves the properties with the name given in the box. The
Save as button also updates the Load list. This is important
if you add or delete files manually.

Tekla Structures stores the properties files in the model
folder, also including the properties of sub-dialogs.
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To modify properties:
1. Double-click an object to open the properties dialog.

2. Toindicate which properties should be changed, select or clear the
desired checkboxes.

For example, if you want some properties to share the same value but do
not want to change any other individual properties, ensure that only the
checkbox for the specific property is selected.

TIP Click to switch all checkboxes on or off.

3. Modify the properties as needed.
Select the objects you want to modify.
5. Click Modify.

Tekla Structures changes the properties whose checkboxes you selected.

See also

View and modify object properties in the property pane (page 78)
Change object properties using the contextual toolbar (page 48)
Copy properties from another object in the property pane (page 85)

Save and load object properties in the property pane or in the dialogs
(page 94)
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6 Customize the basic user
interface elements

You can customize the basic user interface elements according to your needs.
The following user interface elements are customizable:

* ribbon (page 99)

* property pane (page 114)

+ keyboard shortcuts (page 129)

+ toolbars (page 133)

+ contextual toolbar (page 133)

The customizations can be distributed to other users in the company.

6.1 Customize the ribbon

With the Ribbon editor you can customize the ribbon according to your
needs. You can change the size and shape of any button, for example. You
can create user-defined commands, and bring your favorite components and
extensions to the ribbon for an easy access.
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To open Ribbon editor, click File menu --> Settings --> Customize -->

Ribbon.

Ribbon editor - Full: Modeling

W Save W, Revert

Quick Access Toolbar:
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<"+ Add poeints along arc using three arc points
*. Add points along extension of two points

= __Add nnintc at ams nncitinn

Appearance

Icon

MNone

Command: Large icon
Coemmand: Small icon

Command: Scalable icon
Gallery (bitmap)
Gallery (scalable)

Custom

Text

None

Command: Full text Change

® Command: Short text Licen.

Custom

Preview

Drag & drop the preview item to the ribbon.

License
server

With the Ribbon editor, you can

« add new buttons to the ribbon

* move existing buttons on the ribbon

* resize the buttons on the ribbon

+ change the icons and texts of the buttons

* remove buttons you do not need

« create new commands and add buttons for them

* add separator bars to the ribbon

+ add new tabs

NOTE If you want to customize the modeling ribbon, open the Ribbon
editor in the modeling mode.

If you want to customize the drawing ribbon, open the Ribbon editor
in the drawing mode.

You can only customize the ribbons that are available in your
configuration.
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The customized ribbons are saved

to . .\Users\<user>\AppData\Local\Trimble\Tekla
Structures\<version>\UI\Ribbons folder. If you cannot find the folder,
ensure that you are able to view the hidden files and folders on your
computer.

Company administrators can distribute the customized ribbons or tabs to the
whole organization, in the same way as customized property pane layouts.

Add a button to the ribbon

You can add buttons simply by selecting a button type and its appearance and
then dragging the command to the ribbon or to the Quick Access Toolbar.

To Do this
Add a button for a single 1. Inthe Add ribbon item list, select
command Simple button.

2. Inthe Command list, select the
command you want to add to the
ribbon.

You can also add components, macros,
and extensions. Browse through the list
or use the Search box to filter content.
For example, type mesh to find the
Create reinforcement mesh command
and other mesh related components:

Command

mesh x

Component.Reinforcemnent mesh array (91)

Component.Reinforcermnent mesh array in area (..

IIHI Create reinforcement mesh |

Plugin.Mesh Bars

Plugin.Mesh Bars by Area
Plugin.Multi Wire Size Mesh

Reinforcement mesh properties

3. Inthe Appearance list:

+ Select whether the button has an
icon. Select the size of the icon, or
whether you want to use a scalable
icon, or browse for the icon image.
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To Do this

+ Select whether the button has any
text.

Appearance

lcon

Mone

® Command: Large icon

Command: Small icon %
Command: Scalable icon %

Gallery (bitmap)
Gallery (scalable)

Custom

Text

MNone
Command: Full text  Creare reinforcement mesh

® Command: Short text  Mesh

Custom

4. Previewshows what the button looks
like. Modify the button appearance, if
needed.

5. Drag the button to the ribbon.

The blue color indicates the place where
the button will be inserted.

ll'_-lLll Rebar =

| 3 IS

Add a toggle button that Use this to add any switch from the File

switches a particular command | menu --> Settings --> Switches to the

on or off ribbon, for example. You can also add single
snap switches and select switches to the
ribbon.

1. Inthe Add ribbon item list, select
Check button.
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To

Do this

In the Command list, select a command
that can be switched on or off.

Commands that can be switched on or
off have a checkbox next to them.

Command

switch x

k Select all
Select assemblies
Select bar groups in rebar sets
'.: Select bolts
Select components (custom objects)
Select connections
/ Select construction lines
o% Select cuts and added materials
{‘ Select distances
H: select grid

(ESFENRENFESRENEENRENRENAENREN

In the Appearance list:

+ Select whether the button has an
icon. Select the size of the icon, or
whether you want to use a scalable
icon, or browse for the icon image.

+ Select whether the button has any
text.

Preview shows what the button looks
like. Modify the button appearance, if
needed.

Drag the button to the ribbon.

The blue color indicates the place where
the button will be inserted.

b

underneath it

Customize the basic user interface elements

Add a drop-down button
with a group of commands

103

In the Add ribbon item list, select Drop-
down button.

In the Appearance list:

+ Select whether the button has an
icon. Browse for the icon image.
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To

Do this

+ Select whether the button has any
text.

Preview shows what the button looks
like. Modify the button appearance, if
needed.

Drag the button to the ribbon.

The button is now an empty placeholder
for single commands. You need to add
commands to the drop-down button to
make it work.

a. Inthe Add ribbon item list, select
Simple button.

b. Inthe Command list, select the
command you want to add to the
drop-down list.

c. Inthe Appearance list, set the
appearance of the button.

d. Drag the button to the drop-down
list.

The blue color indicates the place
where the button will be inserted.
If you hover over a down arrow,

a list will open and you can drag
commands to the list. The list will
remain open until you click the
down arrow again.

e 5% components -

E Surfaces =

Iy cnmfmnents E& Compare -
Clip angle [141)

! ""%‘i (143)

e. Add as many commands as needed
to the drop-down button.

Add a button for a single
command, plus a drop-down
button with a group of
commands underneath it

Customize the basic user interface elements
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In the Add ribbon item list, select Split
button.

In the Command list, select the
command you want to add to the
ribbon as the main button for the whole
split button.
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To Do this

3. Inthe Appearance list:

« Select whether the button has an
icon. Select the size of the icon, or
whether you want to use a scalable
icon, or browse for the icon image.

+ Select whether the button has any
text.

4. Preview shows what the button looks
like. Modify the button appearance, if
needed.

5. Drag the button to the ribbon.

The button now has a single command.
You need to add commands to the
drop-down list.

a. Inthe Add ribbon item list, select
Simple button.

b. Inthe Command list, select the
command you want to add to the
drop-down list.

c. Inthe Appearance list, set the
appearance of the button.

d. Drag the button to the drop-down
list.

The blue color indicates the place
where the button will be inserted.
If you hover over a down arrow,

a list will open and you can drag
commands to the list. The list will
remain open until you click the
down arrow again.

H
Save

Save as

e. Add as many commands as needed
to the drop-down button.
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You can also drag commands to the Quick Access Toolbar, which is located
above the ribbon, or to the fixed container on the left side of the ribbon:

Quick Access Toolbar:
B DC
Ribbon:
Steel Concrete
g -
[ Column Beam

Move a button
You can rearrange buttons on the ribbon. Note that you cannot move drop-
down buttons underneath each other.

1. Select the button you want to move.
The button becomes highlighted:

%_= Tasks

ﬂ 123.. Sequencer
& | ntting

Locks @ Project status

2. Drag the button to a new location.

The blue color indicates the place where the button will be inserted. For

example:
% Tasks
E 123.. Sequencer ﬂ
om Lotting
Lock
oees ﬁ Project status

Resize a button
You can change the size of existing buttons.

1. Select the button you want to resize:
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b
E
'’

Footing

2. Move the mouse pointer over any side or corner of the button to display a
white arrow symbol:

.-i'll

Footing

3. Drag with the arrow to define a new size:

i

Footing ::: Cast unit

The size of the button changes accordingly. The other buttons are
automatically moved forward on the ribbon, if needed.

=
7
e

-
L"'"- Footing -

4. Double-click the button to expand it.
The button now fully occupies the empty space around it:

g

ﬁ'll

Footing

Change the appearance of a button
You can change the appearance of any button.

1. Select the button you want to modify.

+ If you are adding a new button: select the command in the Command
list.

The current properties of the button are shown in the Appearance list.
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Appearance

fcan
Mone

& Command: Large icon i-lll
Command: Small icon =
Command: 5calable icon  Smm

Gallery (bitmap)

Gallery (scalable)

Custom

Text

Mone
Command: Full text  Crears bois

® Command: Short text  Bair

Custormn

+ If the button already exists on the ribbon: right-click the selected

button on the ribbon.

Concrete View

D'_._l—-l Phases

, Clash check

Command: Large icon

g

anizer

Maone

Command: 5mall ican

® Command: 5calable icon

Gallery (bitmap) Select ...
Gallery (scalable) Select ...
Custom Select ...

Drawings & reports Manaﬁe Analy

%Ta

123.. S¢

gm |
@Pr

\.m Convert IFC objects

R L: % Delete

Text 2

Change command... H

To change the icon, select one of the options:

a. None: noicon is used for the button

108
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Command: Large icon: the default large icon (32x32) is used
Command: Small icon: the default small icon (16x16) is used
Command: Scalable icon: the scalable vector icon is used

Gallery (bitmap): select a large or small bitmap icon from the Tekla
Structures icon gallery

Gallery (scalable): select a scalable icon from the Tekla Structures
icon gallery

Custom: define a custom icon by selecting a suitable image file. The

recommended size is 32x32 pixels for large buttons and 16x16 pixels
for small buttons. If you have problems with your custom image not

appearing the right size, check the DPI setting of the image file. A DPI
of 96 is recommended.

3. To change the name, select one of the options:

None: no name is used for the button
Command: Full text: the default full version of the name is used
Command: Short text: the default short version of the name is used

Custom: enter a custom name for the button

Create a user-defined command with Command editor

You can create user-defined commands and link them to any file or URL.
Create the user-defined commands with Command editor.

The user-defined commands are saved
to . .\Users\<user>\AppData\Local\Trimble\Tekla
Structures\<version>\UI\Commands folder.

1. Click File menu --> Settings --> Customize --> User-defined commands
to open Command editor.

2. Click New.
3. Enter a unique ID for the command, and then click OK.

For example, create a link to the Tekla Discussion Forum. Enter
OpenTeklaDiscussionForum as the ID of the command.

A new column with more properties appears.
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10.
11.

Source Lser

1D f1: OpenTeklaDiscussionForurm
Full name fﬁ My command
Short name () Command
Large icon - M
Small icon - X
Scalable icon O] . X
Tooltip
Action ff} File or URL
Availability v All
+ Modeling
+ Drawing
« Import

In the Full name and Short name boxes, enter a name for the command.

This name will be visible in the Tekla Structures user interface. You
can define two alternative names: a full name and a short version. For
example, enter Tekla Discussion Forum as the full name of the
command, and Forum as the short version.

In the Large icon, Small icon, and Scalable iconsettings, select an icon
for the command.

You can define three alternative icons: a large one and a small one, or a
scalable vector icon.

You can use your own icon or select a suitable icon from the Tekla
Structures icon gallery.

In the Tooltip box enter a tooltip for the command.

For example, enter Go to the Tekla discussion forum.

In the Action box define a file or URL.

For example, enter https://forum.tekla.com.

In Availability, select the mode where the command will be available.
Click Save to save the new command.

Go to Ribbon editor.

Select the button type.
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12. In the Command list, search for the new command you created.
13. In the Appearance list, modify the appearance of the button, if needed.
14. Drag the new button to the ribbon.

k - A—

)
e
>

-

=%

5
B 7 Forum

15. To modify a user-defined command, right-click the command on the
ribbon and edit the command properties just like for any other command.

Add a separator bar

You can add vertical and horizontal separator bars to divide buttons into
smaller groups on the ribbon.

1. Inthe Add ribbon item list, select Separator.

2. Inthe Appearance list, select whether to add a horizontal or a vertical
bar, and the thickness of the bar.

Preview shows what the separator bar looks like.
3. Drag the preview item to the ribbon.

To modify the orientation or the line thickness of the bar, right-click the
bar on the tab and select Orientation or Thickness.

5. To delete the bar, select the bar on the ribbon and press Delete on your
keyboard.

Alternatively, right-click the bar on the ribbon and select Delete.

Remove a button
1. Select the button on the ribbon.
2. Press Delete on your keyboard.
Alternatively, right-click the button on the ribbon and select Delete.

Add, hide, and edit tabs

You can add, move and rename ribbon tabs, choose how they are aligned, and
hide some tabs if you do not need them in your current project. For example,
if you are only modeling steel parts, you can temporarily hide the Concrete
tab.
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To

Do this

Add a new tab

1. Inthe Add ribbon item list, select Tab.
2. Enter a name for the tab in the Text box.
3. Click Add tab to add it to the ribbon.

Change the order of tabs
on the ribbon

Drag and drop the tab titles.

Select how the tabs are
aligned

Right-click in the ribbon area and select one of
the Navigation mode options:

+ Scroll visible: the ribbon movement is
minimal when you switch between the tabs

+ Align to left: the icons start from the left side
of the ribbon

+ Align to tab: the icons start from the left side
of the current tab

Hide the tabs that you do
not need in your current
project

1. Rest the mouse pointer on a tab title.

A small eye symbol appears next to the tab
title:

Vi@%{}

2. Click the eye symbol <.

The eye symbol changes and the tab title
becomes gray:

The View tab is now hidden from the ribbon. If

you slide the ribbon, hidden tabs appear as:

To re-display the hidden tab, click the eye symbol
again.

Rename a tab

Right-click the tab and select Rename. Enter a
new name for the tab.

Remove a tab

Select the tab and press Delete.

Alternatively, right-click the tab and select
Delete.
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Save the ribbon
When you are happy with the changes, save the customized ribbon.

1. In Ribbon editor, click the Save button.

2.  When you return to Tekla Structures and the program asks if you wish
to load the new ribbon, click Yes. The ribbon becomes updated with the
changes you made.

Check the changes

You can compare the original ribbon with the changes you have made. You
can check what has been added and removed, and what has been moved to
different tabs.

1. Save the customized ribbon, if you have not already done so.
2. Click the Compare button.
3. Inthe Compare ribbons dialog, check the changes you have made.

For example:

Compare ribbons - O X

Below are the differences between your current ribbon and the original ibbon.

Not present Moved Customized additions
The following commands are The following commands are The following commands are
included on the ORIGINAL ribbon, found on both ribbons, butthey  included on your customized
but are missing from your appear in different locations: ribbon, but are not part of the
custemized ribbon: ORIGINAL ribbon:
Sequencer Select (Interrupt) Component.Clip angle (141)
Locations: Crriginal locations: Locations
Lotting Customized locations Macro.Create surface view
Locations: Locations:

Macro.Multi-report generator

Locations

Tip: You can drag & drop items from the lists to the nbbon, m

* Not present: these commands have been removed
* Moved: these commands have been moved to a new place

* Customized additions: these commands have been added

NOTE Original ribbon refers to the ribbon file that came with theTekla
Structures installation for your current configuration.
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4. If you have removed a command that you would like to get back, drag it
from the Compare ribbons dialog to the ribbon.

5.  When you are finished, click Close.

Back up and restore ribbons

You can restore the default Tekla Structures ribbons at any time. Before
restoring the default settings, make sure to save a backup copy of your
customized ribbon, because the customizations will be permanently deleted.
You can use the backup file to take your customized ribbon back into use,

to copy the ribbon settings to another computer, or to share the customized
ribbon with your co-workers.

1. To save a backup copy of the customized ribbon:
a. In Ribbon editor, click the Save button.

b. Gotothe..\Users\<user>\AppData\Local\Trimble\Tekla
Structures\<version>\UI\Ribbons folder.

c. Make a copy of the desired ribbon file and save it in another folder.

The ribbons are named according to the Tekla Structures
configurations. For example, in the Full configuration, the name of
the Modeling ribbon file is albl up Full--main menu.xml.

2. Click the Restore button to restore the default Tekla Structures modeling
or drawing ribbon.

3. To take the customized ribbon back into use:

a. Copy the backup file back to
the . .\Users\<user>\AppData\Local\Trimble\Tekla
Structures\<version>\UI\Ribbons folder.

b. When you return to Tekla Structures and the program asks if you wish
to load the new ribbon, click Yes.

The ribbon becomes updated with the changes you made.

6.2 Customize the property pane layout

Tekla Structures shows the model object or the drawing object properties in
the property pane. Use the Property pane editor to customize the property
pane to better suit your needs. You can select separately for each object type
which properties you want to see in the property pane. You can show, hide
and organize the settings in the property pane, and add your most needed
user-defined attributes (UDASs) directly to the property pane.
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To open the Property pane editor, click File menu --> Settings --> Customize
--> Property pane, or, in the property pane, click the Property pane settings

= button and select Customize....

Property pane editor - 0O X

W Saveall ¥, Revert all O Restore all

o Restore  Search o  Add Property pane: Concrete panel
Steel column ® Property -~ "
Steel beam Empty group
Orthogonal beam Special General &
Twin profile Copied properties N
Steel spiral beam ame
Contour plate -

Search Q :
Bent plate Profile
Bolt Drag & drop
4 Material
Weld
Lofted plate ABD Setup _
A : - Finish
Itemn coustic rating
Concrete column Add mesh stabilizing wires Class
Concrete beam Additional information 1
Concrete spiral beam Additional information 2
Concrete panel Additicnal information 3 Cast unit oY
Concrete slab At depth In use X X
] Cast unit numbering
Pad footing Bay number
Strip footing Bottomn Cast unit
Lofted slab .
Cast unit In use

With the Property pane editor, you can
+ organize properties to a suitable order or to suitable groups
« hide or remove properties you do not use or need

+ create your own groups for properties that you find relevant, including
user-defined attributes (UDAs)

* add properties, including user-defined attributes (UDAs), to an existing
group

« create nested property groups

* rename properties or groups

+ save the customized property pane layouts

The customized property pane layouts are saved to

the PropertyTemplates.xml Of PropertyTemplates.Drawing.xml
filesinthe . .Users\<user>\AppData\Local\Trimble\Tekla
Structures\<version>\UI\PropertyTemplates\ folder. If you cannot
find the folder, ensure that you are able to view the hidden files and folders on
your computer.

Company administrators can distribute the customized property pane layouts
to the whole organization, in the same way as customized ribbons or
customized tabs.
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Add a property or a property group
The Property pane editor has three columns:

* Object type list on the left. The list shows all the objects that have a property
pane. Select from the list the object type whose property pane layout you
want to modify.

Each object type's tooltip shows the source from where the object type
definition is loaded: the default source, your environment, or a user-
defined customization.

*  Property list in the middle. The list shows all the available properties
for each model object or drawing object. For model objects, also the
user-defined attributes (UDAs) for each object type are shown. You can
add these properties and UDAs to the property pane layout as regular
properties. Properties which are already in use cannot be added for a
second time but you can reorganize them in the property pane layout.
Properties that are incompatible with the selected object type cannot be
added.

* Property pane layout on the right. It shows the current layout of the
property pane for the selected object type.

To Do this

Select the object type In the object type list on the left, browse through
whose property pane the list or use the Search box to filter content.

layout you want to
modify & Restore | Search Q

Steel column
Steel beam
Orthogonal beam
Twin profile

Steel spiral beam

Add a new propertyto | 1. Inthe middle column's Add section, select
the property pane layout Property.

2. Inthe property list, select a property.

Use the Ctrl or Shift key to select multiple
properties.
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To

Do this

Add

®* Property
Empty group
Special
Copied properties

Search Q
Crag & drop
4

axial2
axialcomp
axialcompd

Camber
3. Dragthe property to the property pane layout
on the right.

You can drag the property to any group in the
property pane.

Add a new group to the
property pane layout

Customize the basic user interface elements

1. Inthe middle column's Add section, select
Empty group.

2. Enter atitle for the new group.
Add
Property
* Empty group
Special
Copied properties
Enter header for the new group:

My UDAs
My UDAs Drag &drcu’p

3. Drag the group template to the property pane
layout on the right.
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To

Do this

You can create a new group, or insert a new group
inside an existing group to create nested groups.

You can reorganize the existing groups by dragging
them.

Add the User-defined
attributes button to the
property pane layout

If you have accidentally removed the User-defined
attributes button from the property pane layout,
you can add it back to the property pane layout for
model objects.

1. Inthe middle column's Add section, select
Special.
Add

Property
Empty group
* Special

Copied properties
User-defined attributes Drag & 'jf':."F'

2. Dragthe User-defined attributes button to
the property pane layout on the right.

Note that the User-defined attributes button
cannot be added for some object types, such as
components.

Some model object types have user-defined attributes that are part of an
attribute group and/or hidden in the Property pane editor. For example,
the Bottom concrete cover belongs to the Concrete covers for rebar sets
group. If you need to use these attributes individually, you can find them
by entering __ (double underscore) in the middle column's search box.

You can also use these attributes in templates. For example, to add the
Bottom concrete cover to a report template, use the value field formula
GetValue ("USERDEFINED. CovThickBottom").

Change the name of a property or a property group

Customize the basic user interface elements

To Do this
Rename a property ora | 1. Inthe property pane layout, select the
property group property or the property group that you want
to rename.
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To Do this

Click 7.
3. Inthe Rename dialog, enter a new name and
click OK.

Alternatively, right-click the name of the property
or the property group and select Rename....

Restore the original 1. Inthe property pane layout, select the group
name of a property or a or the property whose name you want to
property group restore to the original.

2. Right-click and select Restore original name.

Copy properties from one object type to another object
type

You can copy properties from one object type to another object type, for
example, from steel beam to steel plate. If needed, you can copy several
property groups at one go.

1. Inthe object type list on the left, select the object type from which you
want to copy properties.

2. Inthe property pane layout on the right, select the properties you want to
copy.
Use the Ctrl or Shift key to select multiple properties.
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0
3. Click ™ to copy the selected properties.
Alternatively, right-click and select Copy properties.
The copied properties are shown in the middle column, under the
Content section.

Add

Property
Empty group
Special
®* Copied properties
Create a new group that contains the copied
properties:

(Copied from: Steel colummn)

Copied properties Drag &drn}p

Content:

* |FC
IFC building name
IFC building storey name
IFC entity
IFC export type
* My UDAs
User field 1
User field 2
User field 3
User field 4

4. Inthe object type list on the left, select the object type to which you want
to copy the properties.

In the Add section, ensure that the Copied properties option is selected.

Drag the Copied properties box from the middle column to the property
pane layout on the right.
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* Copied properties

Marne
Create a new group that contains the copied i
properties: Profile
(Copied from: Steel column) Material
Copied properties Drag & dr':'.p Finish
Content: Class
- IFC - 27 e
IFC building name Paosition l%%% LO 2
IFC building storey name
IFC entity e
IFC export type
i Rotation
- My UDAs
User field 1 Horizantal
User field 2
User field 3 Position
User field 4
® Copied properties
IFC G
Create a new group that contains the copied
rties:
properties IFC building name (UDA)
(Copied from: Steel column)
IFC building storey name (UDA)
Copied properties S dm’p
IFC entity (UDA)
Content:
IFC export type (UDA)
* |FC
IFC building name In use
IFC building storey name In use My UDAs @
IFC enti In us
entity e User field 1 (UDA)
IFC export type In use
~ My UDAs User field 2 {UDA)
User field 1 In use
User field 2 In use User field 3 (UDA)
User field 3 In use
User field 4 In use User field 4 (UDA)

The names and the content of the copied groups are shown in the middle
column until you copy another group or close the Property pane editor.

If you copy nested groups, all the nested groups inside the main group are
copied, too.
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NOTE Properties that are already in use cannot be added for a second
time. If you copy properties that are already in use, the copied
properties have the text In use in the Content section.

Properties that cannot be added to the selected object type have
the text Incompatible in the Content section.

Set the default visibility for a single property

You can define separately for each object type which properties are visible
or hidden by default in the property pane, and create your favorite sets of
properties.

By default, some object types have a large number of properties visible in the
property pane, and it can be cumbersome to find the needed property among
all the properties. To make the property pane less cluttered, you can mark
properties as frequently or infrequently used and thus hide the infrequently
needed properties.

1. Inthe property pane layout on the right, select the property you want to
mark as frequently or infrequently used. Use the star to mark it frequently

used.
Property.Mame +
Property.5teel.Beam.Profile +
Mark or unmark the property as frequently used
Property.Steel.Material ke
Property.Finish g

« Clear the star selection to mark the property infrequently used. The
property will be hidden in the property pane.

+ Select the star to mark the property frequently used. The property will
be visible in the property pane.

2. To mark several properties as frequently or infrequently used at one go,
use the Ctrl or Shift key to select multiple properties.

When you save the customized property pane layout, only the properties
that have been marked as frequently used are visible.
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Set the default visibility for a property group

You can define whether selected property groups are by default visible or
hidden in the property pane.

1. Inthe property pane layout on the right, select the property groups you
want to hide.

2. Right-click and select Hide by default.

Copy properties I,}, @

Rename... (UDA]
. (UDA)

Show by default . ;

Hide by default

X Delete

The eye icon changes to hidden: #* . The selected property groups are now
by default hidden in the property pane.

3. To have the property groups by default visible again in the property pane,
right-click and select Show by default.

The eye icon changes to visible: €*. The selected property groups are now
by default visible in the property pane.

Note that the property group visibility changes in the property pane (page 89)
override these default settings.

Remove a customization

To Do this
Delete a property or a 1. Inthe property pane layout, select the
property group property or the property group to be deleted.
Use the Ctrl or Shift key to select multiple
properties.
2.
Click % .

Alternatively, right-click a property or a property
group, and select Delete.

Discard changes Click the Revert all button to discard changes and
to revert to the previous save.
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To Do this

Remove a single Click the Restore button to remove the
customization customization of a selected object type's property
pane.

Alternatively, right-click the selected object type
and select Restore to default.

Remove all Click the Restore all button to remove the
customizations customization of all property pane layouts.

Save the changes
When you are happy with the changes, save the customized property pane
layout.

1. Click the Save all button. When you return to Tekla Structures, Tekla
Structures asks if you want to reload the changed property pane
templates.

2. Click Yes to apply the customized property pane layout.

User-defined attributes (UDAs) in the customized property
pane

In the property pane of model objects, the User-defined attributes button
in the More property group opens the user-defined attributes (UDAs) dialog.
If you customize the property pane, you can add your most important UDAs
directly to the property pane, so that you do not need to open separate UDA
dialogs.

Note that the User-defined attributes button is not available for some object
types, such as components. Drawing objects do not have UDAs.

When you create or modify model objects, UDAs are automatically applied
together with all the other object properties. UDAs are automatically applied
regardless of them being in the property pane or in the UDA dialogs.

UDAs with the following unit types are supported and work correctly if they
are added in the property pane: Option, String, Integer, Float, Date,
Distance, Weight, Force, Moment, Angle, Factor, and Area. UDAs with
other unit types need to be used through the UDA dialogs.

NOTE You can control the visibility of UDAs in the property pane also without

customizing the property pane layout. Use the property visibility
options (page 89) and search in the property pane.
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Example: How to add IFC related user-defined attributes to
the property pane layout and copy them to another object
type

This example shows how to add a group of IFC related user-defined attributes

(UDAs) to the steel column property pane layout, and copy the group to the
steel beam property pane layout.

1. Inthe object type list, select Steel column.

Property pane editor
i Save all W Revert all O Restore
<t Restore | Search Q

| Steel column |

Steel beam
Orthegonal beam
Twin profile
Steel spiral beam

Contour plate

2. Inthe Add section, select Empty group. Enter IFC as the title for the new
group.
Add
Property
# Empty group
Special
Copied properties

Enter header for the new group:

[FC

IFE Drag & I:Irl:;p

3. Drag the group template to the property pane layout on the right.

IFC Drag &dru:;p Class
litems |
Position pﬁ%ﬁ% LOJ
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4.
IrC related UDAs.

Add

® Property
Ernpty group
Special
Copied properties

IFC x

Drag & drop
b

IFC building name (Froperty UL
IFC building storey name (Froper.,
IFC entity [Fropert

IFC export type (Froper

property pane layout.

In the Add section, select Property.

In the search, enter IFC to search the

Select all the IFC UDAs and drag them to the group you created in the

Add Property pane: Steel column
* Property S X H s
Empty group
. Material
Special
Copied properties Finiish
IFC x Class
Drag & drop
’ IFC L0
IFC building name (“roperty LD, . =
IFC building storey name (Frop=.., g 4 items -
IFC entity (Property. UDA.IFC_E Position oy
IFC export type (Propery.U0AL. () C 00
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IFC >

IFC building name (UDA)
IFC building storey name (UDA)
IFC entity (UDA)
IFC export type (UDA)

6. When you have added the needed UDAs to the new group, copy the group
so that you can add the group also to the steel beam property pane
layout. Select the title of the group and click the Copy selected items

3
Y button.

Property pane: Steel column

2" e’ x “ i
CIass

IFC )
IFC building name (UDA)
IFC building storey name (UDA)
IFC entity (UDA)
IFC export type (UDA)

The name of the copied property group and the content of the group is
shown in the middle column. You can see that the properties are copied
from steel column.
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Add

Property
Empty group
Special
® (Copied properties
Create a new group that contains the
copied properties:

(Copied from: Steel column)

Copied properties iEg &'.dr-:;p

Content:

- |FC
IFC building storey name
IFC entity
IFC building name
IFC export type

7. To add the copied property group in the steel beam property pane layout,
select Steel beam in the object type list.

8. Drag the copied group from the middle column to the steel beam
property pane layout on the right.

Add Property pane: Steel beam
Property a e x & 7
Empty group
Special
MNumbering series >

® Copied properties
Part beri
Create a new group that contains the art numBoenng
copied properties:

Assermnbly numbering

(Copied from: Steel column) -
e : R———
Copied properties Drag & dru:;p Position ®

Content: On plane
v IFC Rotation
IFC building name
IFC building sterey name At depth
IFC entity
IFC export type Frd offset ®
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Now the IFC related UDAs are available both in the steel column property
pane layout and in the steel beam property pane layout.

Property pane: Steel beam

" " x th 4

IFC >
IFC building name (UDA)
IFC building storey name (UDA)
IFC entity (UDA)
IFC export type (UDA)

9. C(lick the Save all button to save the changes. When you return to
Tekla Structures, Tekla Structures asks if you want to reload the changed
property pane templates. Click Yes to apply the customized property pane
layout.

£} Steel beam 0 X
- -

» General
» Numbering series
¥ IFC

IFC building name

IFC building storey name

IFC entity Auta -
IFC export type Auto -

p Position
P End offset

p Curved beam

P Deforming
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6.3 Customize the keyboard shortcuts

In the Keyboard shortcuts dialog, you can view a list of all shortcuts available
in Tekla Structures. You can define new keyboard shortcuts and remove
existing ones. After customization, you can export the keyboard shortcuts and
share them with your co-workers.

Define new keyboard shortcuts

You can assign keyboard shortcuts to any command, macro, or component.
You can even change the default keyboard shortcuts, if needed.

1. On the File menu, click Settings --> Keyboard shortcuts.
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The Keyboard shortcuts dialog opens.

Keyboard shortcuts — 0O X
Group: Modeling v Import Export Restore
Filter:
a
Contact Tekla support
Contextual help Control + F1
Contextual toclbar Control + K
Continuous Shift + T

Convert IFC ohjects

Convert to a multi-user model

Convert to a single-user model

Convert to conceptual component

Convert to detailed component

Convert to polygon weld

Copy Control + C
Copy - linear

Copy - mirror

Copy - rotate

Copy all content to another object

Conflicts:

Shortcut: Enter shortcut

Assign Cancel Clear Restore

In the Group list, select the shortcut group you want to modify.

A list of commands and shortcuts appears.

If you want to search for a particular command or keyboard shortcut,
enter some text in the Filter box.

For example:

+ Type grid to only see the commands whose name contains the word
"grid".

«  Type "+" to get a list of shortcuts that consist of two parts (such as
Ctri+S).
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« Type ", " to get a list of shortcuts that consist of two consecutive keys
(such as M, N).

Select a command from the list.
Click Enter shortcut.

On the keyboard, enter the combination of keys you would like to use as
the shortcut.

7. Check the Conflicts box to see if the keyboard shortcut is already
assigned to another command.

If the shortcut is already in use, enter a different combination of keys.
NOTE If you reassign a keyboard shortcut that is already used, it will no

longer be associated with the command it was originally assigned
to.

8. Click Assign to save the keyboard shortcut.

Clear and reset shortcuts

You can remove any existing shortcut. You can also reset all shortcuts back to
the defaults.

1. On the File menu, click Settings --> Keyboard shortcuts.

2. Toremove a keyboard shortcut, select the command from the list and click
Clear.

3. Toreset all the keyboard shortcuts to the defaults (page 68), click the
Restore button.

Export keyboard shortcuts

You can export your customized keyboard shortcuts and share them with your
co-workers.

1. On the File menu, click Settings --> Keyboard shortcuts.
2. Click Export.

3. Enter afile name and location.

4. Click Save to export the keyboard shortcuts.

5

To share your keyboard shortcuts with other users, send them the
exported file.

Import keyboard shortcuts
You can import keyboard shortcuts from a file.
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1. On the File menu, click Settings --> Keyboard shortcuts.
Click Import.

Browse for the shortcuts file you want to import.
For example, . .\Users\<user>\AppData\Local\Trimble\Tekla
Structures\<version>\Settings\KeyboardShortcuts 4.xml.

4. Click Open to import the keyboard shortcuts.

6.4 Customize the Selecting, Snapping, and Snap override
toolbars

You can customize the Selecting, Snapping, and Snap override toolbars by
hiding some of the switches. You can customize the toolbars both in the
modeling mode and in the drawing mode.

You can define which selection switches or snap switches are visible and which
are hidden on the selected toolbar. Company administrators can distribute the
customized toolbars to the whole organization.

1. Click the eye button € on the toolbar to open a list that contains all the
switches on the toolbar.

BEOOAXdX~~ X A1 0 n ©

@ [& Snap to points and grid intersections
@ [ Snapte end points

@ (O Snap to center points

« A Snap te mid points

« 3 Snap to intersection points

Alternatively, right-click on the selected toolbar to open the list.
2. To hide a switch, click the name of the switch in the list.

The selected switch becomes hidden on the toolbar and the eye icon
changes to hidden: #*.

3. To have the switch visible again, click the hidden switch in the list.

The selected switch becomes visible on the toolbar and the eye icon
changes to visible: €.

6.5 Customize the contextual toolbar

Use the contextual toolbar to quickly view and change some basic properties
of a model or drawing object, view, grid, and so on. You can customize the
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contextual toolbar by selecting which toolbar elements are visible. You can
also adjust the width of the elements, and add icons and additional titles to
the elements.

A contextual toolbar symbol e appears next to the mouse pointer when
you click an object in a model or in a drawing. Click the symbol to open the
contextual toolbar.

COLUMN HEA40D v § X
0,00 2000 |- @
& B H D =

Customize contextual toolbar

1. On the contextual toolbar, click =,
2. Inthe list of contextual toolbars, select the toolbar you want to customize.

The list of contextual toolbars shows only the toolbars that are available
in the current mode, meaning in the modeling mode or in the drawing
mode.

3. Select and clear checkboxes to define which toolbar elements you wish to
show or hide.

The Preview area shows what the toolbar will look like. For example:

v | 1Name 100

v i 1Profile 100

o ';::'Bottu:um &0

v ';::'Tnp &0

v i iClass 80

v 12 Pasition a0
i 'Phase gp  Preview
' : 1 Material 20 Name
'~ iFinish 60 Bottom Top [ |
T Numbering series 40
EOpen properties 40

v & Copy properties (double-click for multipld0
@Inquire object 40

2 Display detailing a0

v @‘u’iewangle 40

4. To modify the toolbar elements:
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6.

e.

Click the toolbar element.

If the element can be modified, the following box appears:
% D m—f—

Use the slider to adjust the width of the toolbar element.
To add an additional title, click the text box and enter a title.

a=n

To add an icon, click *-* and select an icon from the list.

To remove the icon or title, click 9 .

To add macros and user-defined attributes:

a.
b.

Select the desired macro or user-defined attribute from the list.
Click Add.

Tekla Structures adds the macro or the user-defined attribute to the
list of toolbar elements and to the Preview image. For example:

LOLTom op -

To hide the macro or user-defined attribute, clear the corresponding
checkbox in the toolbar elements list.

Click OK to save the changes.

Create user profiles for contextual toolbars

You can create multiple profiles for contextual toolbars. Each profile contains
the same contextual toolbars, but with different settings.

1.
2.

On the contextual toolbar, click :=.

In the Set profiles box, enter a name for the profile.

Click ™ to save the new profile.

Customize the selected contextual toolbar.

For example, remove some elements from the contextual toolbar.

Click OK to save the changes.

The user profile is now active with the settings you defined.

To switch to another profile:

a.

In the Set profiles list, select another profile from the list.
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b. Modify the settings.
c. Click OK.
This user profile is now active.
When Tekla Structures is restarted, the last used profile is loaded by default.

Back up and share contextual toolbars

We recommend you to save a backup copy of your customized contextual
toolbars. You can use the backup file to copy settings to another computer or
to share the customizations with your co-workers.

1. Save the contextual toolbar under a user profile, with a name that you can
easily recognize. For example, MyContextualToolbar.

2. Gotothe..\Users\<user>\AppData\Local\Trimble\Tekla
Structures\<version>\ContextualToolbar\Profiles folder.

3. Make a copy of your customized contextual toolbar and save it in the
corresponding folder on another computer.

4. To open a customized contextual toolbar on another computer:
On the contextual toolbar, click i=.
b. Inthe Set profiles list, select the correct profile from the list.

For example, MyContextualToolbar, if that is the name you used in
step 1.

c. Click OK.
The customizations are now active.
NOTE Alternatively, you can place the entire ContextualToolbar folderin

your company's firm folder or in the system folder. Note that the firm
folder location needs to be defined in the teklastructures.ini file.
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7 Troubleshooting the Tekla

7.1

7.2

7.3

Structures app

If Tekla Structures does not start after installation, stops responding, or stops
working, the error messages can help you find the cause of the problem.

Error: System.DIINotFoundException

This error message is shown when Tekla Structures cannot start because a
required .d11 file is missing or corrupted in your Windows operating system.

For more information, see Tekla Structures does not start: error
System.DIlINotFoundException.

Error: System.Runtime.Remoting.RemotingException
The following error message is shown:

System.Runtime.Remoting.RemotingException: Failed to connect to an IPC
Port: The system cannot find the file specified.

This message is shown when the required redistributable packages for your
Tekla Structures version are not installed on your computer.

See which additional necessary software components are needed for your
Tekla Structures version in the hardware recommendations. Install any missing
redistributable packages.

Error: APPCRASH TeklaStructures.exe ntdll.dll

The following error message is shown:

Troubleshooting the Tekla Structures app 137 Error: System.DIINotFoundException


https://support.tekla.com/article/tekla-structures-does-not-start-error-systemdllnotfoundexception
https://support.tekla.com/article/tekla-structures-does-not-start-error-systemdllnotfoundexception

Problem Event Name: APPCRASH
Application Name: TeklaStructures.exe
Fault Module Name: ntdll.dll

Usually, this error message is shown when other software prevents Tekla
Structures from running correctly. For more information, see Tekla Structures
product bulletin: Other software hooking to Tekla Structures.

This error message might also be shown if there are problems with the model.
Use the Diagnose & repair commands to check and to repair errors and
inconsistencies in the structure of model objects and the library database. See
Diagnose and repair the model.

Sometimes, installing the latest Tekla Structures service pack might resolve the
problem. See Install Tekla Structures service packs.

7.4 Find information about errors when Tekla Structures
does not show an error message

If Tekla Structures does not start or stops working without showing an error
message, do these steps to find information about the error.

1. In Windows, open the Event Viewer app.
2. Browse to Windows Logs --> Application.
3. Look for an event that has Error in the Level column.
The General and Details tabs show information about the error.

4. If you want to send the error messages when you contact support
(page 142), save the error messages.

a. Select one or more lines.
To select multiple lines, hold down Ctrl or Shift, then click.
b. Right-click the selected lines, then select Save selected events.

7.5 General troubleshooting steps
You can also try these general troubleshooting steps:
« Restart your computer.
* Restart Tekla Structures.

If the Tekla Structures app has stopped responding, you might have to
end the task in the Windows Task Manager before you can start Tekla
Structures again.

+ Install the latest Tekla Structures service pack for your version of Tekla
Structures. See Install Tekla Structures service packs.
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+ If a newer service pack is not available, uninstall and re-install the same
version of Tekla Structures. See Uninstall Tekla Structures.

7.6 Questions and actions for troubleshooting

Question Action

Is your operating system compatible | See the supported operating systems
with the Tekla Structures version that | for your Tekla Structures version in

you installed? the hardware recommendations.

Did the error message appear + Install the latest service pack.
after you installed a specific Tekla See Install Tekla Structures service
Structures service pack? packs.

+ If a newer service pack is not
available, uninstall the current
service pack and install an earlier
service pack. See Uninstall Tekla

Structures.
Are the required redistributable See which additional necessary
packages for your Tekla Structures software components are needed for

version installed on your computer? | your Tekla Structures version in the .

Install any missing redistributable

packages.
Is the error related to your Ensure that your computer meets
computer's performance? the requirements in the hardware

recommendations.

See the recommended hardware for
Tekla Structures workstations in the
hardware recommendations.

Are the latest versions of drivers, such | Compare the versions of the drivers
as graphics card drivers, installed on | that are installed on your computer
your computer? to the latest versions from the
manufacturer.

If necessary, upgrade your drivers.

Are the latest Windows updates Check if Windows updates are

installed on your computer? available and install any missing
updates. For instructions, see Update
Windows.

Are antivirus programs stopping Tekla | Check the settings in your antivirus
Structures from running? software or ask the IT personnel at
your company for assistance.
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Question

Action

Is malicious software or unlicensed
third-party software installed on your
computer?

Use your security software to
scan for and remove malicious
software.

Uninstall any unlicensed third-
party software.

Ask the IT personnel at your
company for assistance.

Are you having the same problem
in more than one version of Tekla
Structures?

If more than one version of Tekla
Structures is not working correctly,
include this information when you
contact Tekla Structures support.

Did you open a model that was
created using a different version of
Tekla Structures?

We recommend that you finish
working on the model using the same
version of Tekla Structures that you
used when you created the model.
You can have multiple versions of
Tekla Structures installed on your
computer at the same time.

Did you recently install other software
on your computer?

Check if other software is
preventing Tekla Structures from
running correctly. See Tekla
Structures product bulletin: Other
software hooking to Tekla
Structures.

Ask the IT personnel at your
company for assistance.

Did you recently install content from
Tekla Warehouse?

Delete the content and check if the
error still occurs.

Are you working in a large model?

See Tips for large models.

Are you working in a multi-user
model?

See Remove inconsistencies from a
multi-user database.

Are you working in a shared model
using Tekla Model Sharing?

Check the prerequisites for Tekla
Model Sharing in Tekla Model Sharing.

Does the error occur only in a specific
model?

Use the Diagnose & repair
commands to check and to repair
errors and inconsistencies in the
structure of model objects and the
library database. See Diagnose and
repair the model.

Do other users see the same error
message when they open the same
model?

Ask another user to try opening the
model.
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Question Action

Does the error only occur in models | Ask the person who maintains the
that were created using a specific model template to use the Diagnose
model template? & repair commands to check and

to repair the model template. See
Diagnose and repair the model.
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8 Contact Tekla Structures
support (Support tool)

The Support tool allows you to contact Tekla Structures support directly.
With this tool you can collect the model, related files, and other necessary
information in one support request, and safely upload your request to Tekla
Structures support.

The Support tool:

+ Automatically identifies the open model and includes either all files or the
files you select from the model folder as attachments to your support
request. Additionally, logs and files from other folders are attached, such as
the user feedback log, Tekla Structures, and user-defined attribute files.

+ Automatically gathers application and system information.

+ Automatically attaches crash dumps, session log files, and Windows Error
logs from the last 72 hours if a crash is encountered. They can be skipped
by clearing the Crash information file category selection.

+ Uploads the problem description, attached model, attached files, and all
other gathered information to the Tekla Structures support.

NOTE Confidentiality information

All files you upload are treated as confidential. Only the recipient can access
the files.

8.1 Create a support request
1. Onthe File menu, click Help --> Contact Tekla support.
2. Login using your Trimble Identity.

The Support tool opens and automatically fills in user, application, and
Tekla Structures version information. The Support tool reads your name,
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email address, company name, and support email address from your
Trimble Identity profile.

3. Select a category from the list of predefined categories, or, if you cannot
find a suitable category, select Other.

4. Enter the problem description.

You can also enter the necessary steps to reproduce the problem or any
questions you may have in the respective text boxes.

Click Next.

Select what you want to attach. The file name, file group, file size, and file
location are mentioned for each file.

+ By default all files are selected.

You can exclude individual files by clearing the checkbox next to the
file.

+ Select the All checkbox, or select specific files from the Select the files
list.

+ If you want to send some other attachments than shown in the Select
the files list, click Add extra files and browse for the files.

+ If you want to send additional crash dump files, click Add crash
dumps and select the relevant files.

« Additional crash dump files and extra files are listed in the Manually
added files file group.

7. Click Next.

The Support tool creates the package and shows the total attachment
size. You can also check application information and operating system
information before finalizing the support case creation.

8. Click Create case to upload your case to Tekla Structures support.

While you create the support case, the navigating back button in the upper-left
corner is disabled for a moment so that you cannot accidentally interrupt the
upload.

When the upload is complete, you will receive a notification at your email
address. After a successful upload, an automatic confirmation message will be
sent to you, and then Tekla Structures support will start solving your case.

NOTE If Tekla Structures crashes so you cannot access the Support tool, you can
create a crash dump file to send to your local support by following the
instructions in How to get Tekla Structures crash dump file. To create a dump
file manually, follow the instructions in How to get Tekla Structures hang
dump file.
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TIP In case of problems, such as difficulties in installing Tekla Structures, you can
also contact your local support directly. For a list of offices and resellers together
with their contact information, see Offices and resellers.
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Interactive help for Tekla
Structures in Trimble Assistant
for Tekla

Trimble Assistant for Tekla is an artificial intelligence (Al) chat service that
provides support for Tekla products.

Trimble Assistant for Tekla has two chat assistants: the User Assistant and the
Developer Assistant.

+ The User Assistant provides support for Tekla Structures and other Tekla
products based on content in Trimble User Assistance.

The User Assistant is available for users who have a Tekla Structures
Diamond, Tekla Structures Graphite, or Tekla Structures Carbon
subscription, or a Partner or Evaluation license.

+ The Developer Assistant helps with writing macros and modifying models
using the Tekla Structures Open API.

The Developer Assistant is available for users who have a Tekla Structures
Diamond subscription or a Partner license, and for users who have joined
the Trimble Labs program.

If you use the Developer Assistant to write macros, we recommend that
you use the Default environment because the Developer Assistant uses
profiles from that environment to generate code.

In Tekla Structures 2026 the Developer Assistant in Trimble Assistant for
Tekla is a Preview feature.

For more information, see the Trimble Assistant for Tekla product guide.

9.1 Trimble Assistant for Tekla side pane

The Trimble Assistant for Tekla side pane lets you use the Trimble Assistant for
Tekla in the Tekla Structures application.
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You can use the User Assistant in a web browser or in the Trimble Assistant
for Tekla side pane. You can only use the Developer Assistant in the Trimble
Assistant for Tekla side pane.

The Trimble Assistant for Tekla side pane is installed by default when you
install Tekla Structures.

An option in the Tekla Structures installer controls whether the Trimble
Assistant for Tekla side pane is installed. If you did not install the Trimble
Assistant for Tekla side pane when you installed Tekla Structures, run the
installer again to install it.
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Neither the Trimble entity granting the license nor any of its affiliates assume
responsibility that the text is free of technical inaccuracies or typographical
errors. The right to make changes and additions to this manual is reserved.

Trimble and certain product names are registered trademarks of Trimble Inc.
in the United States, the European Union and other countries and may have
similar statutory protections. Trademarks of third parties are not mentioned in
this Manual to suggest an affiliation with or endorsement by their owners.

Elements of the software described in this Manual may be the subject of
pending patent applications in the European Union and/or other countries.

Portions of this software:

Portions of this software make use of Open CASCADE Technology software.
Open Cascade Express Mesh Copyright © 2019 OPEN CASCADE S.A.S. All rights
reserved.

FLY SDK - CAD SDK © 2012 Visuallntegrity™. All rights reserved.

This application incorporates Open Design Alliance software pursuant to a
license agreement with Open Design Alliance. Open Design Alliance Copyright
© 2002-2020 by Open Design Alliance. All rights reserved.

CADhatch.com © 2017. All rights reserved.
RapidXml C++ library © All rights reserved.

FlexNet Publisher © 2016 Flexera Software LLC. All rights reserved. This
product contains proprietary and confidential technology, information and
creative works owned by Flexera Software LLC and its licensors, if any. Any
use, copying, publication, distribution, display, modification, or transmission
of such technology in whole or in part in any form or by any means

without the prior express written permission of Flexera Software LLC is
strictly prohibited. Except where expressly provided by Flexera Software LLC
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in writing, possession of this technology shall not be construed to confer any
license or rights under any Flexera Software LLC intellectual property rights,
whether by estoppel, implication, or otherwise.

To see the third party open source software licenses, go to Tekla Structures,
click File menu --> Help --> About Tekla Structures --> 3rd party licenses
and then click the option.
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